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Preface

Preface

Thank you for purchasing this Topcon product. The materials
available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon
products, and are designed to assist owners with the use of the
receiver and its use is subject to these terms and conditions (the
“Terms and Conditions™).

@ Please read these Terms and Conditions carefully.

Terms and Conditions

USE This product is designed to be used by a professional. The user
should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local
government protection agency for both private use and commercial
job sites.

COPYRIGHT All information contained in this Manual is the
intellectual property of, and copyrighted material of TPS. All rights
are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without TPS’ express written consent and may only use such
information for the care and operation of your receiver. The
information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and
arrangement by TPS.
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Preface

TRADEMARKS GRS-1, MG-A8, PG-A1l, PG-AS, RH-1, BH-1, BR-
1, Topcon Receiver Utility (TRU), TopSURYV, TopGIS, Field Tools
for ArcPad, Pocket-3D, Pocket Layout, Topcon and Topcon
Positioning Systems are trademarks or registered trademarks of TPS.
Microsoft, Windows Mobile, and the Windows logo are either
trademarks or registered trademarks of Microsoft Corporation in the
United States and/or other countries. The Bluetooth® word mark and
logos are owned by Bluetooth SIG, Inc. and any use of such marks by
Topcon Positioning Systems, Inc. is used under license. Other
product and company names mentioned herein may be trademarks of
their respective owners.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD
ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE
RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY
OF MERCHANTABILITY OR FITNESS FOR ANY
PARTICULAR USE OR PURPOSE. TPS AND ITS
DISTRIBUTORS SHALL NOT BE LIABLE FOR TECHNICAL OR
EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN;
NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
RESULTING FROM THE FURNISHING, PERFORMANCE OR
USE OF THIS MATERIAL OR THE RECEIVER. SUCH
DISCLAIMED DAMAGES INCLUDE BUT ARE NOT LIMITED
TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS
OF PROFIT, SAVINGS OR REVENUE, OR LOSS OF THE
PRODUCT’S USE. IN ADDITION TPS IS NOT RESPONSIBLE
OR LIABLE FOR DAMAGES OR COSTS INCURRED IN
CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS
OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR
ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO
LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY
OTHER PERSON OR ENTITY IN EXCESS OF THE PURCHASE
PRICE FOR THE RECEIVER.

LICENSE AGREEMENT Use of any computer programs or software
supplied by TPS or downloaded from a TPS website (the “Software”)
in connection with the receiver constitutes acceptance of these Terms
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Terms and Conditions

and Conditions in this Manual and an agreement to abide by these
Terms and Conditions. The user is granted a personal, non-exclusive,
non-transferable license to use such Software under the terms stated
herein and in any case only with a single receiver or single computer.
You may not assign or transfer the Software or this license without
the express written consent of TPS. This license is effective until
terminated. You may terminate the license at any time by destroying
the Software and Manual. TPS may terminate the license if you fail to
comply with any of the Terms or Conditions. You agree to destroy the
Software and manual upon termination of your use of the receiver.
All ownership, copyright and other intellectual property rights in and
to the Software belong to TPS. If these license terms are not
acceptable, return any unused software and manual.

CONFIDENTIALITY This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS’ Confidential
Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade
secrets. Nothing in this paragraph shall restrict you from disclosing
Confidential Information to your employees as may be necessary or
appropriate to operate or care for the receiver. Such employees must
also keep the Confidentiality Information confidential. In the event you
become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the
TPS website (or any other website) or in any other advertisements or
TPS literature or made by an employee or independent contractor of
TPS modifies these Terms and Conditions (including the Software
license, warranty and limitation of liability).

SAFETY Improper use of the receiver can lead to injury to persons or
property and/or malfunction of the product. The receiver should only
be repaired by authorized TPS warranty service centers. Users should
review and heed the safety warnings in an Appendix.
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MISCELLANEOUS The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in
accordance with, the laws of the State of California, without reference
to conflict of laws.

Manual Conventions

This manual uses the following conventions:

Example Description

File » Exit Click the File menu and click Exit.

Connection Indicates the name of a dialog box or screen.

Frequency Indicates a field on a dialog box or screen, or a tab
within a dialog box or screen.

Enter Press or click the button or key labeled Enter.

4
o
-
m

Further information to note about the configuration,
maintenance, or setup of a system.

Supplementary information that can help you
configure, maintain, or set up a system.

Supplementary information that can have an affect
on system operation, system performance,
measurements, or personal safety.

|| D|| 8|0

Notification that an action has the potential to
adversely affect system operation, system
performance, data integrity, or personal health.

viii
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_{ﬂ- Notification that an action will result in system
damage, loss of data, loss of warranty, or personal
[WARNING ) injury.

Under no circumstances should this action be
performed.

P/N 7010-0926 ix
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Notes:
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Chapter 1

Introduction

The GRS-1 receiver is a dual-frequency, GPS+GLONASS L1, L2
receiver and hand-held controller built to be the most advanced,
compact, and portable receiver for the GIS and surveying market. An
integrated electronic compass and digital camera make the GRS-1 an
all-purpose device that can also be utilized as a field collector.

The GRS-1 receiver is a multi-function, multi-purpose receiver
intended for precision markets. Precision markets means markets for
equipment, subsystems, components and software for surveying,
construction, commercial mapping, civil engineering, precision
agriculture and land-based construction and agriculture machine
control, photogrammetry mapping, hydrographic and any use
reasonably related to the foregoing.

The GRS-1 can received and process both L1 and L2 signals,
improving the accuracy of your survey points and positions. The
GPS+ component of GRS-1 receivers means you can access both the
GPS (Global Positioning System) satellites of the United States, and
the GLONASS (Global Navigation Satellite System) satellites of the
Russian Federation, increasing the number of satellites your receiver
can detect, thus improving the accuracy of your survey points,
increasing productivity, and reducing cost.

The dual-frequency and GPS+ features of the GRS-1 combine to
provide the only real time kinematic (RTK) system accurate for short
and long baselines. Several other features, including multipath
mitigation and co-op tracking, provide under-canopy and low signal
strength reception. The GRS-1 provides the functionality, accuracy,
availability, and integrity needed for fast and easy data collection.

P/N 7010-0926 1-1



Introduction

Figure 1-1. GRS-1

Principles of Operation

The GRS-1 is a fully integrated hand-held controller and GPS+
GLONASS L1, L2 receiver. An integrated electronic compass and
digital camera make the GRS-1 an all-purpose, GIS field mapping
unit.

The hand-held controller component of the GRS-1 includes the
Windows® Mobile® operating system and color LCD touch screen.
Integrated Bluetooth® and Wireless LAN technology allows this
system to be a cable-free controller/receiver for maximum portability.
The casing is durable and built for rugged use. As a field controller,
the GRS-1 can run a full suite of field software for working with total
stations and RTK GPS systems.

The GPS+ receiver component of the GRS-1 can receive and
process GPS+GLONASS L1, L2 signals improving the accuracy of
your survey points and positions. The GPS+ features of the receiver
combine to provide a positioning system accurate for any survey.
Several other features, including multipath mitigation, provide under-
canopy and low signal strength reception. When power is turned on
and the receiver self-test completes, the receiver’s 72 channels
initialize and begin tracking visible satellites. Each of the receiver’s
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Principles of Operation

channels can be used to track any one of the GPS or GLONASS
signals. The number of channels available allows the receiver to track
all visible GPS and Glonass satellites at any time and location.

An internal GPS+GLONASS L1 antenna equipped with a low noise
amplifier (LNA) and the receiver’s radio frequency (RF) device are
connected with a coaxial cable. The wide-band signal received is
down-converted, filtered, digitized, and assigned to different
channels. The receiver processor controls the process of signal
tracking.

Once the signal is locked in the channel, it is demodulated and
necessary signal parameters (carrier and code phases) are measured.
Also, broadcast navigation data are retrieved from the navigation
frame.

GNSS Overview

Currently, the following three global navigation satellite systems
(GNSS) offer line-of-site radio navigation and positioning, velocity,
and time services on a global, all-weather, 24-hour scale to any user
equipped with a GNSS tracking receiver on or near the Earth’s
surface:

* GPS - the Global Positioning System maintained and operated by
the United States Department of Defense. For information on the
status of this system, visit the US Naval Observatory website
(http://tycho.usno.navy.mil/) or the US Coast Guard website
(http://www.navcen.uscg.gov/).

* GLONASS - the Global Navigation Satellite System maintained
and operated by the Russian Federation Ministry of Defense. For
information on the status of this system, visit the Ministry of
Defense website (http://www.glonass-center.ru/frame_e.html).

* GALILEO - an upcoming global positioning system maintained
and operated by Galileo Industries, a joint venture of several
European space agencies working closely with the European
Space Agency. Unlike GPS and GLONASS, this is a civil
endeavor and is currently in the development and validation
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stage. For information on the status of this system, visit the
Galileo Industries website (http://www.galileo-industries.net).

Despite numerous technical differences in the implementation of
these systems, satellite positioning systems have three essential
components:

* Space — GPS, GLONASS, and GALILEO satellites orbit
approximately 12,000 nautical miles above Earth and are
equipped with a clock and radio. These satellites broadcast digital
information (ephemerides, almanacs, time&frequency
corrections, etc.).

¢ Control — Ground stations located around the Earth that monitor
the satellites and upload data, including clock corrections and
new ephemerides (satellite positions as a function of time), to
ensure the satellites transmit data properly.

» User — The community and military that use GNSS receivers and
the corresponding satellites to calculate positions.

Calculating Absolute Positions

When calculating an absolute position, a stationary or moving
receiver determines its three-dimensional position with respect to the
origin of an Earth-Center Earth-Fixed coordinate system. To calculate
this position, the receiver measures the distance (called pseudo-
ranges) between it and at least four satellites. The measured pseudo-
ranges are corrected for clock differences (receiver and satellites) and
signal propagation delays due to atmospheric effects. The positions of
the satellites are computed from the ephemeris data transmitted to the
receiver in navigation messages. When using a single satellite system,
the minimum number of satellites needed to compute a position is
four. In a mixed satellite scenario (GPS, GLONASS, GALILEO), the
receiver must lock onto at least five satellites to obtain an absolute
position.

To provide fault tolerance using only GPS or only GLONASS, the
receiver must lock onto a fifth satellite. Six satellites will provide
fault tolerance in mixed scenarios.
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Calculating Differential Positions

DGPS, or Differential GPS, typically uses the measurements from
two or more remote receivers to calculate the difference (corrections)
between measurements, thus providing more accurate position
solutions.

With DGPS, one receiver is placed at a known, surveyed location and
is referred to as the reference receiver or base station. Another
receiver is placed at an unknown, location and is referred to as the
remote receiver or rover. The reference station collects the range
measurements from each GPS satellite in view and forms the
differences (corrections) between the calculated distance to the
satellites and the measured pseudo-ranges to the satellites.

These corrections are then built up to the industry standard (RTCM or
various proprietary standards) established for transmitting differential
corrections and broadcast to the remote receiver(s) using a data
communication link. The remote receiver applies the transmitted
DGPS corrections to its range measurements of the same satellites.

Using this technique, the spatially correlated errors—such as satellite
orbital errors, ionospheric errors, and tropospheric errors—can be
significantly reduced, thus improving the position solution accuracy
of the GPS.

A number of differential positioning implementations exist, including
post-processing surveying, real-time kinematic surveying, maritime
radio beacons, geostationary satellites (as with the OmniSTAR
service), and the wide area augmentation system (WAAS) service.

The real-time kinematic (RTK) method is the most precise method of
real-time surveying. RTK requires at least two receivers collecting
navigation data and communication data link between the receivers.
One of the receivers is usually at a known location (Base) and the
other is at an unknown location (Rover). The Base receiver collects
carrier phase measurements, generates RTK corrections, and sends
this data to the Rover receiver. The Rover processes this transmitted
data with its own carrier phase observations to compute its relative
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position with high accuracy, achieving an RTK accuracy of up to 1
cm horizontal and 1.5 cm vertical.

Essential Components for Quality Surveying
Achieving quality position results requires the following elements:

* Accuracy — The accuracy of a position primarily depends upon
the satellite geometry (Geometric Dilution of Precision, or
GDOP) and the measurement (ranging) errors.

— Differential positioning (DGPS and RTK) strongly mitigates
atmospheric and orbital errors, and counteracts Selective
Availability (SA) signals the US Department of Defense
transmits with GPS signals.

— The more satellites in view, the stronger the signal, the lower
the DOP number, the higher positioning accuracy.

* Availability — The availability of satellites affects the calculation
of valid positions. The more visible satellites available, the more
valid and accurate the position. Natural and man-made objects
can block, interrupt, and distort signals, lowering the number of
available satellites and adversely affecting signal reception.

¢ Integrity — Fault tolerance allows a position to have greater
integrity, increasing accuracy. Several factors combine to provide
fault tolerance, including:

— Receiver Autonomous Integrity Monitoring (RAIM) detects
faulty GPS and GLONASS satellites and removes them from
the position calculation.

— Five or more visible satellites for only GPS or only
GLONASS; six or more satellites for mixed scenarios.

— Wide Area Augmentation Systems (WAAS, EGNOS, etc.)
creates and transmit, along with DGPS corrections, data
integrity information (for example, satellite health warnings).

— Current ephemerides and almanacs.
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Conclusion

This overview simply outlines the basics of satellite positioning. For
more detailed information, visit the TPS website at
WWwWw.topconpositioning.com.

GRS-1 Overview

The GRS-1 is a fully integrated hand-held controller and
GPS+GLONASS L1 receiver. Integrated into the unit is a 72 channel
dual frequency GPS and Glonass receiver, and electronic compass,
digital camera and optional cellular modem for internet connections.

The hand-held controller component of the GRS-1 includes the
Windows® Mobile operating system and color LCD touch screen.
Integrated Bluetooth® and Wi-Fi wireless LAN technology allows
this system to be easily connected to other Topcon sensors or wireless
networks. The casing is durable and built for rugged use.

As a field controller, the GRS-1 can run a full suite of field software
for working with total stations and RTK GPS systems.

The GPS+ receiver component of the GRS-1 can receive and
process GPS+GLONASS L1 and L2 signals improving the accuracy
of your survey points and positions. The GPS+ features of the
receiver combine to provide a positioning system accurate for any
survey. Several other features, including multipath mitigation and co-
op tracking, provide under-canopy and low signal strength reception.

When power is turned on and the receiver self-test completes, the
receiver’s 72 channels initialize and begin tracking visible satellites.
Each of the receiver’s channels can be used to track any one of the
GPS or GLONASS signals. The number of channels available allows
the receiver to track all visible GPS and Glonass satellites at any time
and location.

An internal L1 GPS+Glonass antenna equipped with a low noise
amplifier (LNA) and the receiver’s radio frequency (RF) device are
connected with a coaxial cable. The wide-band signal received is
down-converted, filtered, digitized, and assigned to different
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channels. The receiver processor controls the process of signal
tracking.

After the receiver locks on to four or more satellites, it is possible to
solve the so-called “absolute positioning problem’ and compute the
receiver’s coordinates (in WGS-84) and the time offset between the
receiver clock and GPS time. With the collection of enough
information to solve for position and time the receiver can solve an
RTK position if provided with a differential correction from a base
station or network, or the raw observation data may be stored in the
optional SD card or to the internal memory of the unit for later post
processing with a post-processing software package such as Topcon
Tools.

Capabilities of the GRS-1 receiver include:
e Multipath reduction
* Satellite Based Augmentation Systems supported (WAAS and
EGNOS)

» Dual-frequency static, kinematic, and Real time kinematic (RTK)
survey modes (Use to external GNSS antenna MG-AS or PG-
Al)

* Single-frequency static, kinematic, and differential GPS (DGPS)
survey modes

* Setting different mask angles

* Setting different survey parameters

The integrated 2 megapixel camera is used for taking pictures of
surveyed objects or survey sites.

Getting Acquainted with the
GRS-1

The GRS-1 is an integrated field controller and 72-channel GPS
receiver with an internal electronic compass and digital camera. USB
and serial ports, along with Bluetooth® and Wireless LAN provide
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Getting Acquainted with the GRS-1

communication paths with other devices. An external GNSS antenna
connection allows for an optional MG-AS8 or PG-A1 dual-frequency
antenna to be connected for RTK surveying applications.

The standard GRS-1 package contains the following items:

* GRS-1 integrated receiver/controller activated for GPS+Glonass
L1 signals

* Lithium-ion BT-66Q battery

* Stylus pen

» Power adapter and US to EURO adapter

* USB cable (USB A - Mini B) and power adapter cable
* Hand strap, neck strap, and soft case

» Software CD and operator’s manual CD

* One-year warranty card

For more details on accessories and options available for the GRS-1,
contact your local Topcon dealer.

Rechargeable and Backup Batteries

The GRS-1 comes equipped with a rechargeable battery (Figure 1-2)
for powering the unit. The user can charge the battery in the unit or in
an optional battery charger. A backup battery is also located in the
battery pocket.

The battery provides seven hours of operation, depending on the
mode of the receiver. Under normal conditions, the backup battery
provides eight to ten years of power backup for data and system
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Introduction

integrity. For more information, see “Powering the GRS-1” on
page 2-2.

Battery Cover Latch

Battery

Figure 1-2. GRS-1 Battery

GRS-1 Front

The front of the GRS-1 (Figure 1-3 on page 1-12) is the primary
interface with its components and installed software.

* The internal GPS antenna detects signals from GPS+ satellites
and sends them to the GPS receiver board for processing.

* The display screen and touch panel provides a graphical and
tactile user interface for the unit.

* The power button turns the receiver on and off.

¢ The ESC (escape) button exits from the current screen or
function. Pressing this button for one second or more opens the
Microsoft Windows Start menu.

* The ENT (enter) button applies settings, numerical values, and
records points (depending on the settings of internal software).

* The Bluetooth LED/Wireless LAN LED the status of the
wireless technology module:

1-10 GRS-1 Operator’s Manual



Getting Acquainted with the GRS-1

— Blue blink: Bluetooth is on.
— Red blink: wireless LAN is on.
— Violet blink: notification from Windows.
— No light: the module is off.
¢ The charging LED indicates the level of charge in the battery:
— Green: battery has a full charge.
— Red: battery is charging.
— Red blink: charging error.

* The Cell phone modem LED indicates the receiving status in the
cell phone modem.

— No light: Cell phone is off.
— Green: Cell phone is available.
— Red: Cell phone is in dead space.
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Figure 1-3. GRS-1 Front
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Getting Acquainted with the GRS-1

GRS-1 Back

The back of the GRS-1 holds the stylus used for tapping on the
display screen. An elastic strap provides comfortable security while
using the GRS-1. A cover accesses the rechargeable battery and
backup battery.

External Antenna \

Contact

Cover for RH-1 - el —

Battery Cover —

\
U gggeon
i

Hand Strap Hook

Battery Cover
Latch

Figure 1-4. GRS-1 Back
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GRS-1 Ports

The GRS-1 has the following three ports:

* USB — used for high-speed connection to a computer via
ActiveSync.

¢ Serial — used for communication between the internal GPS
module (port A of the module) and an external device.

* Power — used to connect the GRS-1 to an external power source.
This port can also be used to charge the batteries.

UsSB DC IN
Port Port
ﬂ@ = O
]
[i=) |’
Serial
\U* — Port A
(=)

Figure 1-5. GRS-1 Ports

SD Card Slot

The SD (secure digital) slot provides extended memory for the
controller (Figure 1-6). The user can access the data that resides on
the SD card via the USB port, serial port, or Bluetooth® wireless
technology. A secure digital card can be purchased at your local
computer supply store.
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Located above the card slot is the software reset button for restarting
the operating system if the software is not responding.

Software Reset Button

D

C= 1

@ SD Card Slot

Figure 1-6. SD Card Slot

Integrated Camera

The integrated 2 megapixel camera can be used for taking pictures.

Camera Macro Switch Dial

Figure 1-7. GRS-1 Camera
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External GPS Antenna Connector

The external GPS antenna connector allows an optional external
antenna to be connected to the controller for RTK and post-process
survey applications.

External GPS
Antenna Connector

Figure 1-8. GRS-1 External GPS Antenna Connector
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System Cables

The GRS-1 package includes standard communication and power
cables for communicating with the GRS-1 and providing a power
source. Table 1-1 lists the cables included in the standard GRS-1

package.

Table 1-1. GRS-1 Package Cables

Cable Description

Cable lllustration

AC Power cable and
adapter

Connects the GRS-1 to a
grounded outlet.

Cable p/n 22-060002-01
Adapter p/n 22-060001-01

USB cable

Connects the GRS-1 to an
external device (controller
or computer) for high-speed
data transfer and receiver
configuration.

p/n 14-008081-01

E-Ilﬂ (K] @-- 0]
E/

GRS-1 Software

The GRS-1 comes with the following factory-installed software:

* BTManager — a utility that manages and controls the Bluetooth
module inside the GRS-1. BTManager connects the GRS-1 and
other Bluetooth-enabled devices. For more information, see
“Connecting the GRS-1 and a Bluetooth Device” on page 3-4 and
“Using the Bluetooth Manager” on page 5-1.

» Topcon Receiver Utility — a utility that manages and controls the
compass and GNSS settings. For more information, see
“Surveying with the GRS-1 Using Topcon Receiver Utility

P/N 7010-0926
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(TRU)” on page 3-6 and “Using the GNSS Compass, Camera” on
page 4-1.

* Topcon Communication Manager - TPS Connection Manager is
Topcon’s tool that comes on the GRS-1 field controller to setup
the internal GSM modem for new network connections in
Windows Mobile 6.1.

%8 | TPS Connection Manager ¥ offf X

Connecton Hame
Device Name | Address | | 2/13/09 6:24:48 AM ] Conemction
[/ 44700624  00:03:7a:42:43... e
[P163 3210194 00:10:c6:21:08: bl [Fayes Compatbie on COME_+]
e Th E DGPS Hayes Compatible on COML: -
[ § waar :0e:7b; Y e——
u) b s s asse
HUrE T -
0000 lon: 139 : 42 :© 1320699
[]€3 TopconQ1  00:03:7a:22:1d:5¢ User Name Passwan
[] @ Wokiah73  00:19:79:dd:e5... At B2690°  ‘m [pecmeuince
APN Phone
PDOR, 1.972 £ @0 Ewao.cmqular | |'99"'ll 'l
Hi
RS DA m & o S EEEEEEEEREEE
Check the checkboxes next to the device VEMS: 0.183 m ‘0 oz Tati wlel r]tdydulilole
that you would like to save. cplaf s d] F e Wl

Next Shift] =] xd el vl bl admd . ] 4]~
position [ Svs List | sky plot [ Scaer | ol 41¥
[SS—

(ﬂIa’ui'I“ ilEtE'—i*

Figure 1-9. BT Manager, Topcon Receiver Utility, and Communication Manager

Optional Accessories

Table 1-2 gives a brief list of optional accessories that can be used
with the GRS-1. Contact your dealer to purchase optional accessories.

Table 1-2. GRS-1 Optional Accessories

Accessory Illustration

External GNSS Antenna
for GIS, and Cable
Connecting an external
PG-AS GNSS antenna
increases the range of the
GRS-1.

PG-A5 p/n 01-844201-07
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Table 1-2. GRS-1 Optional Accessories (Continued)

Accessory

Illustration

External Dual-Frequency
GNSS Antenna for Static
and RTK, and Cable
Connecting an external
PG-A1 GNSS antenna
increases the range of the
GRS-1.

External Dual-Frequency
GNSS Antenna for Static
and RTK, and Cable
Connecting an external
MG-A8 GNSS antenna

increases the range of the
GRS-1.

Radio Holder

Connecting the RH-1 radio
holder enables transmit/
receive of correction data
for RTK.

P/N 7010-0926
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Table 1-2. GRS-1 Optional Accessories (Continued)

Accessory

Illustration

Battery Holder

Connecting the BH-1
battery holder enables long

life operation of the GRS-1.

Serial Cable

Connects the GRS-1 to an
external device (controller
or computer) for data
transfer and receiver
configuration.

p/n 14-008080-01

BR-1

The BR-1 is a receiver that
detects signals from local
Beacon stations. When
connected to the GRS-1, it
provides correction data.

p/n 01-852001-01

Lighter Adapter Cable

Connects the GRS-1 to an
automobile cigarette lighter
for power supply

p/n 14-008148-01LF
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Table 1-2. GRS-1 Optional Accessories (Continued)

Accessory

Illustration

Serial Cable for Modem

Connects the GRS-1 to an
external modem.

p/n 14-008104-01LF

Serial Cable for External
Receiver

Connects the GRS-1to a
Topcon GPS+ receiver.
p/n 14-008103-01LF

Battery Charger

Charges the BT-66Q
battery.

p/n 60565
| #ronen
Op ’ Op )
Field Tools for ArcPad, TOIJSU RV
Pocket-3D, and Pocket Field Software
Layout. £12003-2007 Tapcon Corporation R
Verson: 7 | ArcPad’ 7.1
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Option Authorization File (OAF)

Topcon Positioning Systems issues an Option Authorization File
(OAF) to enable the specific options that customers purchase. An
Option Authorization File allows customers to customize and
configure the receiver according to particular needs, thus only
purchasing those options needed.

Typically, all receivers ship with a permanent OAF. When the
receiver is purchased, a new OAF permanently activates the desired,
purchased options. Receiver options remain intact when clearing the
NVRAM or resetting the receiver.

The OAF enables the following functions. For a complete list of
available options and details, visit the TPS website or consult your
TPS dealer.

* Type of signal (standard GPS L1 and GLONASS L1)
(At using internal single frequency antenna)

* Type of signal (optional GPS/GLONASS L2, GPS L2C)
(At using external dual frequency antenna)

RTCM Input/Output (standard)

* Satellite Based Augmentation Systems supported (WAAS and
EGNOS)

RTK at 1Hz, SHz, 10Hz, 20Hz, 50Hz, and 100Hz

* Advanced multipath reduction (optional)

Handling Precautions
* Make sure the GRS-1 is functioning correctly with normal
performance before using it.

* Always make sure the GRS-1 is dry before putting it in the soft
case.

* Do not leave the GRS-1 under strong sunlight for a long time. It
may cause the device to malfunction.
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To ensure IP66 weather proofing, make sure that all of the caps
are closed securely on the unit. (The external antenna connector
has been sealed and will maintain ingress protection from the
elements whether cap is closed or not for external antenna
operations.)

Storing the GRS-1

Always clean the GRS-1 after use.
Use a clean cloth moistened with neutral detergent or water.

Never use an abrasive cleaner, ether, thinner benzene, or other
solvents.

Always make sure the GRS-1 is completely dry before storing it.
Dry any moisture with a soft, clean cloth.
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Notes:
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Chapter 2

Preparing the GRS-1
for Use

Before using the GRS-1, make sure the battery is fully charged. If you
are using other survey software, such as TopSURYV, install it in the
office. Insert an optional SD card before beginning to survey.

Attaching the Hand Strap

The hand strap provides a comfortable, secure support for using the
GRS-1 on the job. The velcro extender at the bottom of the strap
allows for comfortable re-adjustment of the strap for larger or smaller
hands.

To attach the hand strap, thread the bottom end of the strap through
the hook on the bottom of the GRS-1 and press the velcro together.
Gently stretch the strap, and insert the metal end of the strap into the
strap slot on the back of the GRS-1.

Hand Strap Slot Hand Strap
|

% - )
=

(|

Figure 2-1. Attaching the Hand Strap

When replacing the battery, remove the top end of the strap to access
the battery door latch.

P/N 7010-0926 2-1



Preparing the GRS-1 for Use

Powering the GRS-1

The GRS-1 uses a BT-66Q battery for it’s primary power source.
When using the GRS-1 for static surveys, the battery will last up to
four hours. The battery will last up to fifty hours during continuous
standby use (that is, no GPS usage, the display LED is off, and the
touch screen is not being used). A backup coin battery and
rechargeable battery back up the GPS and clock settings.

Installing the Battery

The rechargeable battery can be charged using the power port and AC
adapter (see “Charging the Battery” on page 2-3), or either the
optional wall charger or cigarette lighter adapter.

To remove/replace the battery (Figure 2-2) do the following:

1. If needed, unhook the top of the strap from the GRS-1.

2. Open the battery cover, and remove the primary battery. The
GRS-1 automatically turns off when the battery cover is opened.
When the battery cover is opened, the device automatically
switches to suspend mode (power off).

3. Replace the battery with a fully charged one, making sure the (+)
and (-) symbols on the bottom of the battery are aligned with the
symbols in the battery casing.

4. Press to close the battery cover until it clicks into place, and
reattach the hand strap.

If the battery cover does not close, rotate the battery
180 degrees.
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Powering the GRS-1

Battery Cover Latch

Battery

Figure 2-2. Installing the Primary Battery

Charging the Battery

The AC/DC converter AD-11 provides power to the GRS-1 and
charges the primary battery. Note that using the GRS-1 while
charging increases the charge time. The battery will be fully charged
in approximately seven hours.

To charge the battery using the converter
(Figure 2-3 on page 2-4):

1. Plugthe AC/DC converter connector into the power (DC-IN) port
of the GRS-1.

2. Plug the converter into a grounded outlet.
The Charge LED lights up. The battery is fully charged after
about six hours.

The charging LED indicates the level of charge in the battery:
* Green — battery has a full charge.
* Red — battery is charging.
* Red blink — charging error.
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Connector — € AD-11B/11C

Figure 2-3. Charging the Battery in the GRS-1

To charge the battery using the optional charger (Figure 2-4):

1. Remove the battery from the GRS-1 (see “Installing the Battery”
on page 2-2 for details), and insert it into the charger.
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2. Plug the charger into a grounded outlet.

To Grounded
Outlet S
Q

Figure 2-4. Charging the Battery in the Optional Charger

Charging and Battery Storage Notes

To keep the battery properly charged, maintained, and stored, do the
following:

* Only recharge the battery at room temperature, approximately
50°F to 104°F (10°C to 40°C). Charging at a high temperature
increases the time it takes to charge the battery.

* Always check the battery charge before using the GRS-1. The
battery will discharge during storage.

» Charge a stored battery every seven days. Allowing a battery to
become discharged can reduce the overall performance of the
battery and charge efficiency.

* Be aware that the charger may become somewhat heated while
charging the GRS-1.
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Replacing the Backup Battery

The backup battery ensures GPS and clock settings are saved when
the primary battery and internal rechargeable battery are depleted.
Under normal conditions, the backup battery lasts two to three years.

The Windows Mobile RAM has a separate backup,
rechargeable battery. This battery will power the
RAM for five minutes after removing the primary
battery.

The backup battery is a CR2032 coin battery that can be purchased at
many general retailers. You will need Phillips-head and flat-head
screwdrivers to replace the backup battery. Follow these steps to
replace the backup battery as shown in (Figure 2-5).

1.
2.

Open the battery cover and remove the primary battery.

Using a Phillips-head screwdriver, remove the coin battery/SIM
card cover.

Using a flat-head screwdriver, insert the tip of the screwdriver in
the slot to the left of the coin battery. Gently push the coin battery
to the right to pop it out of the holder. Repeat these steps on the
left side of the holder to remove the coin battery.

Replace the battery within a couple of minutes to
prevent data loss.

Insert the new coin battery, plus side up, into the holder. Slide the
coin battery under the tabs and gently push into place.

Replace the coin battery cover and screw.
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Screw T g
Coin Battery/SIM Card Cover A

Figure 2-5. Replacing the Coin Battery

Starting the GRS-1

To start the GRS-1, briefly press the power button. The touch screen
lights up, and the GRS-1 splash screen displays while the system
loads, and then the Microsoft Windows Mobile desktop displays.

Press Power
Button to Start

Figure 2-6. Press Power to Start the GRS-1

Calibrating the Touch Screen

The touch screen needs to be calibrated when first starting the GRS-1
or after a hard reset. The configuration function automatically starts
and is simple to complete.

1. On the main screen of the GRS-1, press the Start # icon.
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2. Press Settings » System tab » Screen

s | Settings

Screen

Orientation
@ Fortrait -
(O Landscape (right-handed) jl
(O Landscape (left-handed)
Align Screen

Align the screen if it is not responding

accurately to stylus taps.

General | ClearType ] Text Size ]

Figure 2-7. Stylus Properties

3. Press Align Screen.

4. Press and hold the stylus on the center (+) of the cross lines
(targets) as it moves about the screen.

)

2
Figure 2-8. Calibrate the Touch Screen

5. Once the target stops moving and the device is recalibrated, press
OK at the top of the screen.
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Setting the Power Management

The power management feature prevents battery depletion by
automatically conserving the power through the Standby (no GPS
usage, the display LED is off, and the touch screen is not being used)
or Suspend (power off) mode when the unit is left turned on.

To set the Standby or Suspend mode:

1. On the main screen of the GRS-1, press the Start # icon.

2. Press Settings » System tab » Power.
The Power Properties window appears with the Advanced tab
open.

& | Settings

Power

On battery power:
Turn off device if nat
o o

On external power:

Turn off device if not |:|
used for

Barnen'l Ad\rancedl Em:mall Backupl RTCl

Figure 2-9. Power Properties

3. Check the On battery power: Turn off device if not used for
check box, and then select a time from the drop-down menu.
Repeat for the On external power: Turn off device if not used
for check box and drop-down menu.

4. Press OK at the top of the screen.

Installing Software

The GRS-1 runs the standard Microsoft® Windows® Mobile®
operating system and applications. When installing other software
applications onto the GRS-1, Microsoft ActiveSync (Windows XP
and earlier operating systems up to Windows 98) or Windows Device
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Center (Windows Vista) is required. The following software may be
useful for taking full advantage of the integrated features found in the
GRS-1 controller/receiver:

* TopSURYV - full-featured data collection software used on a hand
held controller. TopSURY is structured into several modules to
provide the user with a scalable, cost effective application that
can be utilized for all Surveying tasks. Use TopSURYV to
measure and capture rich survey data sets with all types of
Topcon sensors.

* Field Tools for ArcPad — field data collection software used on a
hand-held controller for GIS surveys. It is structured to provide
the surveyor with capture and update functions for geographical
data in a wide range of GIS-related applications.

* Topcon Receiver Utility (TRU) — a utility that configures GPS
and DGPS receivers connected to a hand-held controller.

Installing software onto the GRS-1 requires a connection to a
computer that contains the software. Software is first downloaded
onto a desktop/laptop computer, then installed onto a connected
controller via Microsoft ActiveSync.

Refer to the corresponding manual for specific instructions to install
software onto the GRS-1.

Installing Microsoft ActiveSync ActiveSync or Windows Device
Center is available for free from the Microsoft website
(www.microsoft.com) and must be installed on the computer before
installing software onto the GRS-1.

Installing an Optional SD Card

SD (secure digital) cards can be purchased at a local computer supply
store. When inserted into the GRS-1, an SD card provides additional
data storage, as well as data transfer. The GRS-1 supports SD cards
with up to 2 GB capacity. This device does not currently support
SDHC cards.
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Installing an Optional SD Card

Some SD cards may not be used with the GRS-1.

1. Open the SD card slot door.
2. Gently insert an SD card into the slot as shown in Figure 2-10.
3. Close the SD card slot door.

] =1gE

Figure 2-10. Insert SD Card
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Notes:
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Connecting the GRS-1 with Other Devices

Using the GRS-1

The GRS-1 can be used as a stand-alone hand held L1 device for
mapping, or with the external PG-A1 antenna as a dual frequency
RTK rover. When installing software or performing file transfers, the
USB cable or Bluetooth module connects the GRS-1 to a computer
for in-office processing. The GRS-1 can also be used as a controller
for other Topcon measurement devices such as manual and robotic
total stations, digital levels, and dual frequency receivers.

Connecting the GRS-1 with
Other Devices

The GRS-1 provides for direct connection to devices with either a
mini serial or USB port, devices that support Bluetooth and wireless
LAN operations, or with an external GNSS antenna (PG-A1, PG-A5
or MG-ASR), as well as an optional internal cellular modem for
network connections for either differential corrections or pushing data
to the internet. The various devices are optional and can be purchased
from your local Topcon dealer or at a commercial retail store for
commercially sold products (such as the SD card).
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External Antenna PG-A1, PG-A5
(Optional)

External Antenna MG- A8
(Optional)

External Antenna Cable
Radio Holder for GRS- 1 (Optional)

RH- 1 (Optional) -/

Beacon Receiver
BR-1 (Optional)

DGPS Correction
Information

AC/DC Power
Converter AD-11

- Serial Cable
s for D-Sub 9pin
ptional)

AN
Serial Cable

Correéiion Information
for BR-1(Optional)

(Other than BR- 1)

PC
(Sold Separately)

Battery Recharger
BC-30
(Optional)

Figure 3-1. GRS-1 System Connections

Connecting the GRS-1 and a
Computer

Connecting the GRS-1 and a computer allows you to install software
onto the controller and upload data from the controller to a computer.

1.

Before connecting the GRS-1 and a computer, make sure
Microsoft ActiveSync is installed on the computer. See
“Installing Software” on page 2-9 for details.

For a Bluetooth connection, see “Connecting the
GRS-1 and a Bluetooth Device” on page 3-4 for
details.

Connect the GRS-1 and the computer using the interface cable F-
25 (USB) or Bluetooth wireless technology.
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Computer

USB Cable
B @-- |

Figure 3-2. Connect GRS-1 and Computer (USB) Using Cable

3. When ActiveSync on the computer prompts to set up a
partnership, select No, and click Next.

4. Once the connection has been established, click the Explorer
icon on the ActiveSync screen to view data on the GRS-1 on-
board memory.

About ActiveSync and Windows Mobile Device
Center

If you are using the Windows 2000 service pack 4 or Windows XP
operating system, then download ActiveSync from the Microsoft
website and install it to your computer. If you are using the Windows
Vista operating system, then download Windows Mobile Device
Center from the Microsoft website and install it on your computer.

The method for downloading and installing ActiveSync and
Windows Mobile Device Center is described at the following URL:
www.microsoft.com/windowsmobile

* ActiveSync 4.2 and 4.5 is supported by Windows 2000 service
pack 4 and Windows XP.

* Windows Mobile Device Center 6.1 is supported by the Windows
Vista operating system.
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See the help section of the software for details on how to set up and
use the software. If a connection is not possible with your computer,
see the Microsoft website (http://support.microsoft.com/kb/259369)
or contact the support center for the computer you are using.

Connecting the GRS-1 and a
Bluetooth Device

The GRS-1 is equipped with Bluetooth capability, so you can
transmit data wirelessly between equipment. The Bluetooth Devices
screen displays the List of Favorite Devices, so you can quickly and
easily connect with a saved device. If the device you are looking for is
not listed, then you can search for up to nine other Bluetooth-enabled
devices within range. Make sure the devices you are searching for are
discoverable.

To connect with a paired device:

1. From the Bluetooth Devices screen, highlight a device, and press
Device » Pair.

Device Name Address
TopconHQL 00:03:7a:22:fd:5f
321-0194 00:10:c6:2f:08:d5
447-00624 00:03:7a:4a:43:85

Pevice View Tools Help

Figure 3-3. Bluetooth Devices - Select

2. If you cannot find a saved device on this screen, then press Tools
» Device Discovery. An hourglass appears while BTManager
searches the List of Favorite Devices and then searches for up to
nine nearby Bluetooth-enabled devices.
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7 | Bluetooth Manager

Device Name

[ Address [l

[ :d WindowsCE

O ; W3IT
D:medmsctz
[J 3 wsar

IT

=2 Qe:7b:0d:aa...
le:dc:ﬂﬁ:zo...
103:7a:17:4f...

00:03:7a:30:cf:ff

[J6) 321-0194  00:10:c6:2f:08:...
[J J nokiaN73  00:19:73:dd:eS...
[JdWindowsCE  00:03:7a:18:53... [=
|:| a 1S 000014  00:02:c7:60:9f:...

00:0e:7b:84:94...
001 Fe 6760

Check the checkboxes next to the device
that you would like to save.

Figure 3-4. Bluetooth Devices - Discovery

3. After the devices are found, you can:

* Select a device, and tap Next. You can choose more than one
device.

* A confirmation message appears when the devices are
successfully added to the List of Favorite Devices.

&4 x

oth De:

Pairing

Tap Next to begin pairing Bluetooth

devices. Pairing creates a bond between
Ilhe computer and your Bluetooth device.

%s | Bluetooth Manager

B
TOPCON

This process is only required once per
Bluetooth device.

e~ |

Figure 3-5. Bluetooth Devices - Pairing
4. Pairing Bluetooth Devices
* Select a device on My Bluetooth Device Screen.
* Press Device » Pair
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 Enter the pass key.

If an error message displays upon trying to connect, then it
usually means that the security settings of the remote device do
not correspond to the security settings of the GRS-1.

To correct this, make sure the Pass Key, Authentication, and
Encryption check boxes on the My Bluetooth Device screen
correspond with the security settings of the remote device.

For more information about troubleshooting error messages, see
“Bluetooth Problems” on page 7-8.

For more information about connecting devices and using
Bluetooth Manager, see “Using the Bluetooth Manager” on
page 5-1.

Surveying with the GRS-1
Using Topcon Receiver Utility
(TRU)

The GRS-1 can be used in many surveying situations. From GIS
surveying to data collection on a construction jobsite, the GRS-1
provides an integrated solution for all your needs.

Simple surveying (data collection) with the GRS-1 can be handled
with the on-board TRU software. Other surveys may require an
external GPS antenna and/or a Beacon receiver to acquire GPS
signals or correction data for better position accuracy.

Surveying with the GRS-1

For more information on TRU, see the Topcon Receiver Utility
Operator’s Manual.

1. Complete any required pre-survey steps as described in
Chapter 2.

Open TRU, and press Device » Connect.
3. Select Connect Using » Serial Port, Port Name » Com?7.
4. Press Connect.
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10.

Surveying with the GRS-1 Using Topcon Receiver Utility (TRU)

Open Receiver Settings » Tracking.

Check the antenna, and elevation mask, and PDOP mask settings.
For typical surveys, the antenna should be set to Internal.

Press OK.

Open Status.

The Position Information window appears.

Press the SVs List tab.

The Satellite Information window appears.

Press the Sky Plot tab.
The Sky Plot Information window appears.

Surveying with the GRS-1 and an
External Antenna

1.

A

Complete any required pre-survey steps as described in
Chapter 2.

Open TRU, and press Device » Connect.

Select Connect Using » Serial Port, Port Name » Com7.
Press Connect.

Open Receiver Settings » Tracking.
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6. For the Antenna setting, select External.

Connect GRS-1 and
& 24 x External GNSS Antenna

O Intermal Current Input (——

@ External
O tute

 Elevation Mask, deg
Satelittes Tracking

e ——
[v]
PDOP mask for position computation
& g
.

Figure 3-6. GRS-1 and PG-A1/PG-A5/MG-A8 Antenna Setup

Select External

7. Edit the interval and elevation mask settings as needed.

Surveying with the GRS-1 and a
Beacon Receiver

1. Complete any required pre-survey steps as described in
Chapter 2.

. Setup the Beacon receiver according to its documentation.
3. Using BTManager, connect the GRS-1 and GPS receiver as

described in “Connecting the GRS-1 and a Bluetooth Device” on
page 3-4. In BTManager, the BR-1 would be considered an

“Unclassified” device.
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Surveying with the GRS-1 Using Topcon Receiver Utility (TRU)

Connect GRS-1 and
BR-1 Receiver via Bluetooth

Figure 3-7. GRS-1 and BR-1 Setup

4. Configure the GRS-1 for data collection as described in the

corresponding software manual. For example, if you are using
Field Tools as the data collection software, then refer to the Field
Tools Reference Manual.

Ensure the survey configuration is for an external
receiver.

Begin logging data using the data collection software.

When you reach a location to record a point, pause and press the
Ent (Enter) button on the GRS-1. Wait until the point is recorded
before moving to the next location.

Surveying with the GRS-1 and an
External GPS Receiver

This setup uses Bluetooth wireless technology for communication
between the GRS-1 and a GPS receiver.

1.

Complete any required pre-survey steps as described in
Chapter 2.

Setup the external GPS receiver according to its documentation.

Using BTManager, connect the GRS-1 and GPS receiver as
described in “Connecting the GRS-1 and a Bluetooth Device” on
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page 3-4. In BTManager, the GNSS receiver would be considered
an “Unclassified” device.

[

e} O °© e}
oL OO00000 ¢ ]

Connect GRS-1 and n
GNSS Receiver via Bluetooth |

Figure 3-8. GRS-1 and HiPer Series Receiver Setup (Using Bluetooth)

4. Configure the GRS-1 for data collection as described in the
corresponding software manual. For example, if you are using
TopSURYV as the data collection software, refer to the TopSURV
Reference Manual.

Ensure the survey configuration is for an external
receiver.

5. Via the data collection software, begin logging data.

6. When you reach a location to record a point, pause and press the
Ent (Enter) button on the GRS-1. Wait until the point is recorded
before moving to the next location.
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Chapter 4

Using the GNSS
Compass, Camera

Topcon Receiver Utility

Topcon Receiver Utility for GRS-1 is a simple utility that manages
the compass and receiver board settings in the GRS-1. When first
opening Topcon Receiver Utility or after a reset, all settings will be at
the default selections. Typical GNSS settings only need to be
configured once. Occasionally, individual uses may require different
settings. Topcon Receiver Utility saves logged satellite information.
Table 4-1 summarizes the screens and settings in Topcon Receiver
Utility.

Table 4-1. Topcon Receiver Utility Screens

Description Screen

v B —
The Status screen displays the current Svc _\UST| EL]AZ[CA| LIP) L2P S

Oeps 841+ 98 47 18 ;ﬂ

position, satellite information, sky plot, Oeps 1062+ 334 51 28

and position in time. s 1531+ 234 46 18 17
gﬂ"j 24 29+ 314 45 13 14|
Peps 26 49+ 232 S0 24
Peps 27 41+ 142 47 19

Leps 2922+ 298 41 10
Q6o 43 21- 38 37 35
QGO 49 44+ 94 39 39
Q6o 51 50- 22 41

O sBas IAIJIJIJIJI_
Oseas| 137 72| 72| 45| 22| 7,
4] ] | [»
position | svs List | sky Plot | scatter | pof 4T¥

SSE_E_E

4
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Table 4-1. Topcon Receiver Utility Screens (Continued)

Description Screen

Receiver Settings

Antenna
@ |Internal Current Input:

O exerml
(@)

Elevation Mask, deg

Position Computation: |:E

| PDOP mask for position computation

The receiver settings (tracking options)
screen selects the antenna (internal or
external), elevation mask, and PDOP
mask.

) )
-

Tools

The tools screen allows you to clear the
NVRAM and reset the receiver. | Reset Receiver |

| Clear NVRAM |
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Topcon Receiver Utility

Table 4-1. Topcon Receiver Utility Screens (Continued)

Description Screen

Receiver Options

Antenna

The receiver options screen displays an @ [intermal Current Input:
Option Authorization File (OAF) O Exteral
information and allows you to upload an O A

OAF file. Elevation Mask, deg

Position Computation: |:E
PDOP mask for position computation

) )
-

()

Compas em ]
s: 316°18°

The Compass tab in GMS/GRS Tools & g
displays the magnetic North direction. -, 5
The angle to North displays the pitch and

roll of the unit and calibrates the

270
6

compass. <
£ A
(':.\ c,‘v
|Tilt:<-0°34° 081
T19°35

Receiver | Modem | Compass |

] FiddiA|

Using the Compass

Press Start » TRU » Device » GMS/GRS Tools.

The Compass tab displays the current direction, roll, and pitch of the
GRS-1. This tab also calibrates the compass.

* Pointer — North (red portion of pointer) and South (black portion
of pointer) directions.
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* Angle — the angle (azimuth) from North, in degrees.

* Tilt — the roll and pitch, from level, in degrees minutes.

Eﬁ: 316°18"

0
- 5
[=]
5 8
& A
e &
|Tilt:<-0°34° 081
T19935°
Receiverl Modeml Cornpassl

] FiddiA|
Figure 4-1. View the Compass

Declination is the angle between magnetic north and true north. The
compass shows magnetic north. In order to determine the coordinates,
it is necessary to correct the declination.

Inclination is downward in the northern hemisphere. Because the
compass detects the horizontal component of a magnetic field,
azimuth accuracy worsens in the high magnetic area where a
magnetic horizontal component is small.

The compass function can be used in the area within +/- 70 degrees
magnetic latitude.

Magnetic Field Distortions occurs near ferrous materials and
material that disturbs a magnetic field, such as:

* The inside and surrounding area of a railroad, car, and ferro-
concrete building.

* A magnet, motor, and electric products, including digital camera,
personal computer, data collector, etc.

* The surrounding area of a plant that induces a magnetic field like
a high-voltage line and substation.

* The surrounding area of a metal (iron, nickel, and cobalt) mine.
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* A wrist watch. (Keep a distance of 15 cm or more between the
GRS-1 and a wrist watch.)

Because azimuth accuracy worsens near ferrous materials as
described above, correct the azimuth by methods other than
magnetism. For example, you can:

* Determine the coordinates of two points from the DGPS function.
(The distance of two points must be 120 m or more.)

* Determine the right azimuth from two known points on a map.

Do not use an AC/DC adaptor at the time of
compass use.

Calibrating the Compass

Calibrate each location before starting the measurement for an
accurate value.

When the unit is turned on, the previous calibration will be used. See
also “Recalibrating the Compass” on page 4-8.

To calibrate the compass:
1. Open TRU, and press Device » GMS/GRS Tools » Compass

tab.
m :316°18°
* 0
- 5
[=]
5 8
& A
e &
|Tilt:<-0°34° 081
T19°35"
Receiverl Modeml COIT!DaSsl

Figure 4-2. Compass Tab
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2. Press Calibrate, and then start the calibration as shown in
Figure 4-3.

& TRU 24 %
Perform the compass calibration procedure
according to the manual,
Then press OK.
o1
i

Figure 4-3. Begin Compass Calibration
3. Hold the GRS-1 horizontally in your hand and turn to any
direction.

4. Rotate the device 360 degrees in a horizontal direction for five or
more seconds. See Figure 4-4.

5. Rotate the device 360 degrees in a roll direction for five or more
seconds. See Figure 4-4.

6. Rotate the device 360 degrees in a pitch direction for five or more
seconds. See Figure 4-4.

7. Turn your body 90 degrees in any direction, and repeat steps 4, 5,
and 6.

Figure 4-4. Calibrating the Compass
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8. Press OK.
If calibration is successful, the Calibration completed
successfully window appears, and the calibration value is saved.
Press OK.

Perform the compass calibration procedure
according to the manual.

Then press OK.

("i ) Calibration completed

successfully.

Figure 4-5. Calibration Successful

If you did receive an error message, then you may have rotated
the device too quickly or in the wrong direction. Try to
recalibrate the compass.

Perform the compass calibration procedure
according to the manual.

Then

Calibration failed. Try
again?

Figure 4-6. Calibration Error

If a calibration error appears several times, change the direction a
little and try again.
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Recalibrating the Compass

Recalibration is needed in the following cases:

The survey location changes frequently.

The GRS-1 receives a shock, such as being dropped.
The temperature changes 10 degrees or more.

The device is transported by car or airplane.

The device is attached to metal objects, such as a tripod and a
pole.

The battery is exchanged.
The magnetic field changes, such as an approaching car.

The device is near a strong magnetic object or material, such as a
permanent magnet, electromagnet, motor, transformer, AC power
supply, speaker, etc.

Viewing GNSS Information and
Settings

For more GNSS information and settings on TRU, see the Topcon
receiver Utility Operator’s Manual.

Using the Camera

To take a picture:

1.

Press Start -> Pictures & Videos.
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2. Press the Camera icon.

7y  Pictures & Videos

Camera M Menu Thumbnails

Figure 4-7. Take a picture

3. Aim the camera at the desired object(s), using the finder/review
pane to frame the image.

4. Press the ENT key on the GRS-1 to take the picture.
5. Press Thumbnails.
6. Check to save the picture.

Camera i Menu

Figure 4-8. Save a picture
Adjust camera settings using the following selections:

Press Menu on the camera finder screen.
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* Brightness — Select a brightness of the captured image. Settings
are from -3 to +3.

* Resolution — select the resolution in bits of the image to capture.
Settings are from 160x120 to 1600x1200.

* Zoom - select the scaling factor. Settings are from zoom 1 to 4.

7s | Pictures & Videos o oz ok

Video

Mode b
Brightness »
Resolution »
Zoom b

Full Screen
Options...

Figure 4-9. Adjust Camera Settings

To set the macro and long distance modes: turn the dial to the left
for macro mode and to the right for long distance mode as shown in
Figure 4-10.

Do not use the camera with the camera dial set
@ halfway between the macro and long distance mode

settings.
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Long Distance Mode
(90 cm or more distance)

Y.

Macro Mode
(Approx. 5-10 cm Distance)

\%'

Figure 4-10. Camera Dial Modes
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Notes:
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Chapter 5

Using the Bluetooth
Managenr

The BTManager utility controls the GRS-1 Bluetooth module.

Getting Started

To start BTManager:

1. Turn on the GRS-1.

2. Press the Bluetooth icon in the system tray, and select Bluetooth
Manager from the pop-up menu.

:: BlueTray o 43 :: BlueTray

. Friday Friday
February 13, 2009 February 13, 2009

8:0on 8:0on
) Getting Started ® Getting Started
Tap here to set owner information $  Tap here to set owner information
No unread messages HNo uni
Nc No
| No upcoming appointments | Mo upcoming appeintments
Live Search Live Search

o' Device unlocked o' Device unlocked

| Turn Transmitter OFF

S L Bluetooth Manager
Calendar Contacts Calendar About.

Figure 5-1. Starting Bluetooth Manager

3. If the Bluetooth transmitter is switched off (The Bluetooth icon is
gray.), select Turn Transmitter On to turn on Bluetooth.

P/N 7010-0926 5-1



Using the Bluetooth Manager

Getting Acquainted

Table 1-1 summarizes the screens and settings in BTManager.

Table 5-1. BTManager Screens

Description

Screen

Type of devices to detect

This screen displays types of
devices to discover. Once a device
type is selected, the Discovery
Wizard searches for those devices
when you tap Next.

7 | Bluetooth Manager

The Discovery Wizard is ready to search
for Bluetooth devices. Select the type of
Bluetooth devices that you would like to
discover and tap Next to begin the

(@ Any Bluetooth device|
(O Computer
(O phone
(O LAN/Network Access Point
(O Peripheral
(O Imaging
(O Miscellaneous
O Unclassified
| < Back | | Next > |

()

Device List

This screen displays all discovered
devices of a selected type. From
this list, you can choose a device to
add to your List of Favorite Devices
by tapping Next.

%s | Bluetooth Manager

Device Name I Address I
447-00624  00:03:7a:4a:43...
321-0194  00:10:c6:2M08:...
O 3wsir 00:0e:7b:0d:2a...
[ 3 s24sH 00:1c:eeic6:ba:...

[JE3 1S 000014 00:02:c7:60:9f:...
TopconHQ1  00:03:7a:22:fd:5F
[J A NokiaN73  00:19:79:dd:e5...

Check the checkboxes next to the device
that you would like to save.

| < Back | | Next > |

()
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Getting Acquainted

Table 5-1. BTManager Screens (Continued)

Description

Screen

List of Favorite Devices

This screen displays your preferred
Bluetooth-enabled devices. You
can use the Device Discovery
wizard option in the Tools menu or
the Bluetooth Devices screen to
search for Bluetooth-enabled
devices within range and save them
to this list for future connections.

g Bluetooth Manager

EBEBEB

TopconHQL  321-0194  447-00624

Device View Tools Help

My Bluetooth Device

This screen displays the internal
GRS-1 Bluetooth module
information. On this screen, you
can set your preferences and choose
how to connect with other devices.

& 4% ok

My

%s | Bluetooth Manager

T Bluetooth Device

Class (Major): Computer
Class (Minor):  Palm

Pocket_PC

00:03:7a:6¢:d3:39

Device Name:

Address:

Discoverable \Authentication|
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Table 5-1. BTManager Screens (Continued)

Description

Screen

Pairing

This screen displays when the
GRS-1 is in pairing mode, and it
accepts a pairing request initiated
by a remote device.

%s | Bluetooth Manager

24 %
Bluetooth Device

Pairing
Tap Next to begin pairing Bluetooth

devices. Pairing creates a bond between
Ilhe computer and your Bluetooth device.

TOPCON

This process is only required once per
Bluetooth device.

Bluetooth Devices

This screen displays the List of
Favorite Devices. If you do not see
a device that you are looking for on
this list, then you can tap Find to
search for it.

Device Name Address

£3 TopconHQ1 00:03:7a:22:fd:5f
8 321-0194 00:10:c6:2f:08:d5
8 447-00624 00:03:7a:4a:43:85
< ] | [»

Device View Tools Help
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Table 5-1. BTManager Screens (Continued)

Description Screen
About BTManager
. . . 7 Bluetooth M o fz X
This screen displays version and LS *
copyright information for Biuetooth Manager

TOPCON

About

BTManager.

BtManager Version 2.23.1,
December 10, 2008

Copyright © 2006-2008

Topcon Positioning Systems

Working with Bluetooth
Manager

Before the GRS-1 can pair with another Bluetooth-enabled device, it
must discover which devices are available within your coverage area.
You can use the Device Discovery wizard to search for any
Bluetooth-enabled device within range or a particular type of device,
and then save the device(s) to your Bluetooth Devices folder for
future connections.
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& | Bluetooth Manager o X

8 8 O

TopconHQ1 321-0194 447-00624

-
>

Device View m Help

Figure 5-2. List of Favorite Devices

Discovering Devices

To discover other Bluetooth-enabled devices within your coverage
area.
1. Tap Tools » Device Discovery.

The Discovery Wizard appears (Figure 5-3).

7a | Bluetooth Manager

Bluetooth Device

TOPCON P
Discovery

Tap Next to discover new Bluetooth
devices. Make sure the new devices are
on and in Discoverable mode.

| [ nexe> ]

()

Figure 5-3. Discovery Wizard
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2. Tap Next to display a list of device types.

7s | Bluetooth Manager P dl E

The Discovery Wizard is ready to search
for Bluetooth devices. Select the type of
Bluetooth devices that you would like to
discover and tap Next to begin the

(@ Any Bluetooth device|
(O Computer
(O phone
(O LAN/Network Access Point
(O Peripheral
(O Imaging
(O Miscellaneous
O Unclassified
| < Back | | Next > |

()

Figure 5-4. Device Categories

3. Choose a type of device to discover, and tap Next.

The Discovery Wizard searches for Bluetooth-enabled devices in
your coverage area and displays the icons of the devices it detects
on the Device List.

As device names and addresses are retrieved, the Device List
updates with detailed information (Figure 5-5 on page 5-8).

Once the Device List is populated, you can add any device from this
list to the List of Favorite Devices.

If you select the “Any Bluetooth device” option and
the device you want is not displayed in the Device
List (Figure 5-5 on page 5-8), then select a more
specific category to narrow the range of the devices
you want to discover.

@ Only up to nine devices can be discovered at a time.
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Adding to the List of Favorite Devices

The Device List displays all discovered Bluetooth-enabled devices in
your coverage area.

To add a device from the Device List to the List of Favorite Devices:
1. Select a device, and tap Next. You can choose more than one

device.

%s | Bluetooth Manager Fadl ER

Device Name IAddr&es I
447-00624  00:03:7a:4a:43...
321-0194  00:10:c6:2M08:...
O 3 warr 00:0e:7b:0d:2a...
[ 3 s24sH 00:1¢:ee:c6:ba:...
[JE3 1S 000014 00:02:c7:60:9f:...
TopconHQ1  00:03:7a:22:fd:5f
[] 3 hokia N73  00:19:79:dd:e5...

Check the checkboxes next to the device
that you would like to save.

| < Back | | Next > |

()

Figure 5-5. Select Device(s)

A confirmation message appears when the devices are
successfully added to the List of Favorite Devices.
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2. Tap Finish to exit the Wizard and display the List of Favorite
Devices.

%s | Bluetooth Manager

Success!

You have added 2 new device(s).
Tap Finish to exit.

| < Back | | Finish |

()

Figure 5-6. Devices Added

To save time, you can save Bluetooth-enabled devices on the List
of Favorite Devices, so you do not have to rediscover it. You can
view devices by icon and name or by name and address.

% | Bluetooth Manager o X

8 8 O

TopconHQ1 321-0194 447-00624

| Device Discovery

Device View m Help

Figure 5-7. List of Favorite Devices
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To display the list of devices by name and address, tap
View » Details.

Device Name Address

TopconHQL 00:03:7a:22:fd:5f

321-0194 00:10:c6:2f:08:d5

447-00624 00:03:7a:4a:43:85
< ] | [»
Device View Tools Help

Figure 5-8. Details on Bluetooth Devices

Viewing Device Properties

To view the properties of a device, select the device in the List of
Favorite Devices (Figure 5-7 on page 5-9), and tap
Device » Properties.

%s | Bluetooth Manager Fadl ER

Bluetooth Device

TOPCON .
Properties

9 Class (Major):  Unclassified
Class (Minor):

Device Name: 447-00624
Address: 00:03:7a:4a:43:85

Supported Services:
Fositioning

Figure 5-9. Bluetooth Device Properties

The Bluetooth Device Properties screen displays major and minor
class identifiers, the name, and address of the selected device.
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Deleting a Device from the List

To delete a device from the List of Favorite Devices:
1. Select the device, and tap Device » Delete.

A confirmation message appears.
2. Tap Yes to delete the device.

Device Name Address
£3 TopeonHQ1 00:03:7a:22:fd:5f

(2 ) Confirm deletion of the
device "447-00624°7

h| ] | [»
Device View Tools Help

Figure 5-10. Deleting a Device

Setting Device Preferences

The My Bluetooth Device screen (Figure 5-11 on page 5-12) displays
information about the internal GRS-1 Bluetooth module. The
preferences you set on this screen determine how your GRS-1 pairs
with and connects to remote devices.
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To access the My Bluetooth Device screen, tap Device » My
Bluetooth Device.

%s | Bluetooth Manager o oz ok

My

TOPCON g, tooth Device

Class (Major): Computer
Class (Minor):  Palm

Device Name:  Pocket_PC

Address: 00:03:7a:6¢:d3:39

Discoverable \Authentication|

Figure 5-11. My Bluetooth Device
My Bluetooth Device always displays the following information:
* (lass (major and minor)
* Name (Other devices use this name to identify the GRS-1.)
e Address

This screen also allows you to enable the following accessibility
options:
* Discoverable: allows other devices within range to find the
GRS-1.

* It is not necessary to enable this option when initiating a
connection from the GRS-1 and for most dial-up networking.

* When not in use, disable this option manually to save power.

* Connectable: allows other devices within range to connect to the
GRS-1.

* It is not necessary to enable this option when initiating a
connection from the GRS-1 and for most dial-up networking.

* Authentication: authenticates the identity of other devices. Select
this option if you want to require a passkey to connect with
another Bluetooth enabled device. If either or both devices use
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authentication, then a passkey must be entered. Once
Authentication is selected, the Passkey can be edited.

» Encryption: secures all data sent over Bluetooth.

Typically, Topcon Bluetooth-enabled GPS
receivers do not require a PIN upon connection. If it
is necessary, however, the PIN (up to 16 characters)
can be set for a Topcon GPS receiver by BTCONF,
the Topcon Bluetooth module configuration
program.

Eam Topcon Total Stations require a PIN on connection.
NOTE Typically, the PIN value is set to “1111”. This value
can be changed.

* Service Mode: BTManager allows the GRS-1 to connect with
other Bluetooth-enabled devices using serial port or dial-up
services. The connecting device needs to support the service
selected:

» SPP (Serial Port Profile): provides serial port connection with
peripheral Bluetooth-enabled devices, including GPS
receivers which normally do not require authentication.

* DUN (Dial-up Networking Profile): provides a standard to
access dial-up services over Bluetooth. The most common
scenario is using a mobile phone as a modem.

Pairing Bluetooth Devices

The Pairing Mode allows a remote Bluetooth-enabled device to
initiate a request to pair with the GRS-1. If the Pairing Mode option is
activated, then the GRS-1 switches to Pairing Mode for two minutes.
During this two-minute period, any remote device can attempt to pair
with it.

The GRS-1 accepts the first pairing request if the security settings on
the remote device match the GRS-1 security settings. You do not
need to activate the Pairing Mode option if the GRS-1 initiates the
pairing request.

P/N 7010-0926 5-13



Using the Bluetooth Manager

To activate Pairing Mode, tap Device » Pair.

% | Bluetooth Manager ot X
00:03:7a:66:55:¢2
£3 TopconHQ1 00:03:7a:22:fd:5f
a 321-0194 00:10:c6:2f:08:d5
a 447-00624 00:03:7a:4a:43:85

[ Properties |
Delete
My Bluetooth Device...
Rt -

Devicel View Tools Help

Figure 5-12. Device Menu - Pairing Enable

The Pairing screen appears, displaying how much time is left to
pair with another device.

72 | Bluetooth Manager o 4 X

Bluetooth Device
Pairing
Tap Next to begin pairing Bluetooth

devices. Pairing creates a bond between
Ilhe computer and your Bluetooth device.

TOPCON

This process is only required once per
Bluetooth device.

Figure 5-13. Pairing Mode
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Once the two minutes expires, a message appears stating if the pairing
succeeded or failed.

7% | Bluetooth Manager Fadl ER 7% | Bluetooth Manager

Pairing will be attempted with the Success!
following device:

Device Name:
8 evice Name PP-0003 You are now paired to the following

Device Address: 00:03:7a:66:55:c2 device:
PP-0003
Please make sure the Bluetooth on the
device is enabled and will accept pairing. Tap the Finish button to exit the Wizard.
Tap Next to continue...
[ <Back ][ Next> ] | [ Finish |

() i

Figure 5-14. Pairing Confirmation

For information about connecting Bluetooth Devices, see
“Connecting the GRS-1 and a Bluetooth Device” on page 3-4.

For information about troubleshooting Bluetooth error messages, see
“Bluetooth Problems” on page 7-8.
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Notes:
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Chapter 6

TPS Gonnection
Managenr

TPS Connection Manager is Topcon’s tool that comes on GRS-1 field
controller to setup the internal GSM modem for new network
connections in Windows Mobile 6.1.

The tool includes the following functionality:
* Power on the modem and dial based on settings.
* Define the settings for new network connection.
* Power on the GPS receiver.

To run the tool, tap the TPS Connection Manager start icon in the
lower right corner of the Windows Mobile screen that opens upon
turning the GRS-1 on.

Y | Start E ¥ o fm
Thursday 12:30 AM TPS
January 01, 2009 .
i : oF Connection
D Gatting Started Manager Icon

Tap here ta set awner information
Ma unread messages

Na Esks

| Ma upcaming appaintments

Notificabon Contacts

Figure 6-1. Start TPS Connection Manager

Tapping the TPS Connection Manager icon brings up the Main Menu.
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TPS Connection Manager

Main Menu

The Main Menu displays the menu to access the main options
available in the TPS Connection Manager.

& | start & & o< fm

§ Thursday 12:41 AM
January 01, 2009

8 o
% Gering Starbed
. Tap here ta set awner information

Ma unread ressages
aming appainknents

ic:  Callular power on
Rezume cellular powear

Create new conhechon entry

GPS Receiver Power
—
HNotifica LI

Figure 6-2. Main Menu
Cellular power on — turns on the cell phone power.

Resume cellular power — if this Resume function for the internal
GSM is ON (checked with a tick), the GSM power state is
automatically restored when the GRS-1 is turned on.

Data connection — sets up network connections to the best
available for “My ISP”. It is grey out when the GSM power is
OFF.

Create new connection entry — adds new network connections.

GPS Receiver Power — turns on the GPS receiver power.

* About — this will show the TPS Connection Manager version.
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Create New Connection

Create New Connection

When selected, the Create new connection entry option will open the
dialog to enter settings for a new network connection.

Create -

=

NeW Connection Hame
. |Connection 2 |
Connection adem
Entry Hayes Compatible an COM1: v|
Operatar Name
-
Lser Harre Password
r— |
APN Phane
|intemet.mts.ru | |"‘99““"‘=1# v|
i2s| 1z 3]4lslal7lslslol-|=]«
Tablolwlelrltlylulilelpl[]]
caplalsldlflolhlilklil:]"|
shift | 2 | ] elvlblnlml | . Ji]l+~
cillaal 1] (N

Figure 6-3. Create New Connection Entry
« Connection Name — the new connection name.

* Modem - selects the modem type from the predefined list. The
default selection is preferable.

» Operator Name — selects the operator from the predefined list.

» User Name, Password, APN, Phone — these will set the user
name, password, Access Point Name (APN) and phone dial
number to log on to the remote network. The dial number can be
edited using the current input panel.

 Create — tap to create the new connection. The successful
message will display (Figure 6-4 on page 6-3).

 Exit - tap to close the screen.

{§ 3 Connection created
- successfully

Figure 6-4. Connection Created

Tap OK to close the message and return to the main menu.
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TPS Connection Manager

Cellular Power On

You need to turn on the cell phone power to dial to the Internet.

& | start & & o< fm

§ Thursday 12:40 AM
January 01, 2009

i 9o
@ Getting Started

2 Tap here ta set awner information

a Na unread messages

. Na Esks

“ upcarning appaintments
Live Search
i Cellular power on
v Resume cellular powrer

Data connecHon

Create new conhechon entry

GPS Receiver Power
About

Figure 6-5. Cellular Power On

* Cellular power on — check mark this item to turn the GSM on.
Note that the Data Connection option becomes available.

* Resume cellular power — check mark this option to have the GSM
power turned on after a soft reset or switching the GRS-1 off.

Data Connection

This option is used for dialing the cell phone to reach the Internet.
The Data Connection option is disabled if the GSM power is turned
off.

Note that, if ActiveSync connection is established and the PC has an
internet connection, then this connection will be selected.

The TPS Connection Manager creates new connections for “My ISP”
predefined “network”. When the user wants to connect to the Internet,
Windows Mobile connection manager automatically selects the best

available connection from dial-up connections to an Internet Service

Provider.
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Data Connection

Data — " | Settings E ¥ s ok
COHHCCtiOH Nebwork Management ;a

Programs that autormatically connect to the
Internat shauld connect using:

-

Programs that automatically connect to a
private nebvork shauld connect using:

My Work Network ~|

Figure 6-6. My Internet Service Provider Connection

You can check that the connection is established if you tap the status
El icon on the top of the screen. Tapping this arrows status icon
brings up a screen to view network status. To check or modify the
settings of the created network connection, you can use standard
Windows Mobile interface:

1. Go to Settings on the Windows Mobile screen.

ﬁ‘ Joday
[i; Cffice Mobile
B Calendar

5:. Contacts

£ IntemetExplorer o o
a Messaging

B_ Eile Explorer

l'.- Programs

Settings —» [E BT

Notificabon Contacts

Figure 6-7. Settings
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TPS Connection Manager

2. Select the Connections tab and then the Connections icon.

% | Settings & &4 X T | Settings & &4 X
) =
OOEE st Lock Besm  Bluetooth
ﬁ [ i " Wz A
= e @ W a7 @l
Menus Owner Sounds & Domain Hetwork  USE ko PC
Informabon Hotificalions Enroll Cards
0) @
Today Wireless
Manager
Parsanal | S','stem| Connections | Parsaral | System [ Connections

Figure 6-8. Connections

3. You will see “My ISP” connections. If there is no “My ISP”
network listed, then you will need to open the Advanced tab and
select “My ISP” as an active network.

€:. | Settings & & 45 ok
Connections Q
My ISP

Add a newe madem connection
Manage existing connecians

My Woark Nebwork

Al @ new radem connection
Add a new WEH server cannechan

St up Iy proxy server

Tacks | Advanced |

Figure 6-9. Settings - My ISP

You can also open the Internet Explorer on the Windows Mobile to
check on the Internet availability (Figure 6-10 on page 6-7).
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il windowsidefault 0409 htinjRglad
2 ivEmet Explorer Mobile [
¥ ol |
Favorites Vl
History ¥ | E
123l 1|z 3 ]4lslsl7lala]o]-|=]«
Tablalwlelclolylulilelpl[]]
CAPlals|dlflalblilkll];:]"
shife | z x| elvlblnlm] | . ]i]l <
cofail 1] N
Henu

Favorites =

Figure 6-10. Internet Explorer

GPS Receiver Power

Check mark the GPS Receiver Power option to turn on the GPS
receiver in the GRS-1 system.

GPS
Receiver
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§ Thursday
January 01, 2009

B o
) Gaekting Started

Tap here ta set awner information

Ma unread ressages

ing appaintments

LCellular power on

Rezume cellular powear

Create new conhechon entry

GPS Receiver Power

About

Figure 6-11. GPS Receiver Power

GPS Receiver Power
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TPS Connection Manager

About the Tool

Select the About option from the main menu to view information
about the TPS Connection Manager version.

v | Start & & 45 ok

TPE Connection Manager 1.0
January 21, 20049

{c) 2009

Tapcon Fosibaning Systems

Figure 6-12. About TPS Connection Manager
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Chapter 7

Troubleshooting

This chapter will help you diagnose and solve some common
problems you may encounter with the GRS-1.

'ﬂT Do not attempt to repair equipment yourself. Doing
so will void your warranty and may damage the
hardware.

[WARNING )

Check This First!

Before contacting Topcon support, check the following:

* If software is unresponsive, perform a software reset. See
“Resetting the Software” on page 7-3 for details.

¢ Check all external connections (cable and wireless).

* Check all power sources for drained batteries or incorrectly
connected batteries/cables.

* Check that the most current software is downloaded onto the
GRS-1, and the most current firmware is loaded into the receiver.
Check the TPS website (www.topconpositioning.com) for the
latest updates.

Then, try the following:
* Reset the hardware. See “Resetting the Hardware” on page 7-4.

* Restore default settings for the Bluetooth module and GPS+
receiver. See “Restoring Bluetooth Module Defaults” on page 7-4
for details.

* Clear the SDRAM (remove the battery).

If the problem persists, see the following sections for other solutions.
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Troubleshooting

Troubleshooting Quick List

To reset the software, see “Resetting the Software” on page 7-3.
To reset the hardware, see “Resetting the Hardware” on page 7-4.
For power problems:

If “The GRS-1 does not power up” see page 7-6.
For general GRS-1 problems:

If “The GRS-1 is not receiving data (corrections) from an
external receiver” see page 7-7.

If “Installed software and other data has been erased” see
page 7-8.
For Bluetooth problems:

If “The GRS-1 is no longer connected via Bluetooth” see page 7-
8.

If “You cannot connect to another Bluetooth-enabled device” see
page 7-8.
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Resetting the Software

Resetting the Software

Only perform a software reset in the following instances:
* To quit all active applications.
» After installing new applications.

* When there is no response after pressing a key or tapping on the
screen.

When a software reset is performed, all running applications stop and
unsaved data is lost; however, all installed programs and saved data is
protected.

To perform a software reset:

1. Disconnect all cables and remove the inserted SD card.

2. Use the stylus pen to lightly press the software reset button at the
upper section of the SD card slot (Figure 7-1).

Reset Button

|=

(@)
Ul — = = @

Figure 7-1. Resetting the Software
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Troubleshooting

Restoring Bluetooth Module
Defaults

If the Bluetooth module is not performing as expected, try returning
the settings to the defaults.

For the Bluetooth module, tap Reset on the Accessibility tab in
BTManager.

Resetting the Hardware

If the GRS-1 does not operate after a software reset or the GRS-1 has
become completely unresponsive, then perform a hardware reset. A
hardware reset reverts all settings to defaults and erases all
applications and data stored in RAM.

A hardware reset erases all RAM data and
applications.

Regular backups ensure RAM data and applications
can be restored.

To perform a hardware reset (Figure 7-2 on page 7-5):

1. Disconnect all cables and remove the inserted SD card.

2. Simultaneously hold the ENT and ESC buttons while pushing the
software reset button with the stylus pen for two or more seconds
(Figure 7-2). The unit turns off.

3. Press the Power button.
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Format Reset

e —

(&)

L — = O 9
Push the Software Reset I

Button While Pressing <

the Ent and Esc Buttons —

Figure 7-2. Resetting the Hardware

Completely draining the battery performs the same function as a
hardware reset.

Format Reset

If the GRS-1 does not operate properly after a hardware reset perform
a format reset. When the format reset is performed, the registry
information registered by applications to the OS are reset. Data stored
by the user is saved; however, the time setting and shortcut
information created on the desktop and for program folder is
initialized. In such a case, it is necessary to reset the time, and then
reinstall applications.
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Troubleshooting

m If the equipment does not work normally after the
format reset, it needs repair. Please contact your
local Topcon dealer or Topcon.

[WARNING )

To perform a format reset (Figure 7-3 on page 7-6):

1. Disconnect all cables and remove the inserted SD card.

2. Simultaneously hold the ESC and ENT buttons while pushing the
software reset button with the stylus pen for two or more seconds
(Figure 7-2 on page 7-5). The GRS-1 turns off.

3. Simultaneously hold the ESC and Power buttons until the GRS-1
restarts (for about 10 seconds).

Figure 7-3. Format Reset

Charging/Powering Problems

The GRS-1 does not power up

= The batteries may be discharged.

» Connect the GRS-1 to a grounded outlet to charge the battery.
See “Charging the Battery” on page 2-3.

* Insert a fully charged battery. See “Installing the Battery” on
page 2-2.

= The charging cable may be disconnected or damaged.
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GRS-1 Problems

Check that the cable is securely connected and undamaged.

= The GRS-1 may have a defective charger or defective internal
battery.
If, after changing the battery or connecting an external power
source, the GRS-1 still does not power up, contact TPS
Customer Support for advice. See “Obtaining Technical
Support” on page 7-10.

GRS-1 Problems

The following are some of the most commonly encountered problems
with the GRS-1.

The GRS-1is not receiving data (corrections) from an external
receiver

= Check the Bluetooth LED. The LED will be blue when a
connection has been established.

= Check if BTManager was closed manually.

If BTManager was closed manually (tapping the close button
on the title bar), the port used for communication between the
GRS-1 and an external device will be disconnected from the
Bluetooth module.

1. Open BTManager and check the Bluetooth Indicator:

* Red — no connection between BTManager and the
Bluetooth module.

* White — a connection between BTManager and the
Bluetooth module has been established.

» Green — via a serial port, a connection between the GRS-1
and an external Bluetooth-enabled device has been
established.

2. If needed, select the device to connect to, and tap
Connect.

For more information, see “Connecting the GRS-1 and a
Bluetooth Device” on page 3-4.
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Troubleshooting

Installed software and other data has been erased

= The battery in the GRS-1 has been completely drained or a
hardware reset has been performed.
Reinstall all software. See “Installing Software” on page 2-9
and the software manual for details.

Restore data backed up from the CF card.

Bluetooth Problems

The following are some of the most commonly encountered problems
with the GRS-1.

The GRS-1is no longer connected via Bluetooth

= Check the Bluetooth LED. The LED will be blue when a

connection has been established.
For information about connecting Bluetooth devices, see
“Connecting the GRS-1 and a Bluetooth Device” on page 3-4

You cannot connect to another Bluetooth-enabled device

= If you encounter an error message while pairing with other
Bluetooth-enabled devices, use Table 7-1 to learn which
actions to take to correct the error.
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Bluetooth Problems

Table 7-1. Most Common Errors

Error Message

Action to Take

Winszerror o

The security account
database contains an
internal inconsistency.

File: \BtDrtApi.cpp
Line: 127
Function: BthPairRequest

1. The PIN you entered on the My Bluetooth
Device page does not match the PIN you entered
on the remote device. Make sure the GRS-1 and
the remote device use the same PIN.

2. The Connectable setting was not selected on the
remote device or the device was switched off.
Make sure the remote device is on and the
Connectable check box on the My Bluetooth
Device page is selected.

3. The remote Bluetooth device is already being
used and it does not support simultaneous
Bluetooth connections. Close the connection
between the remote device and other device.

GMS.2 BT errar [Br] =]

Confirming the condition
(the connectable, security)
of other devices.

Set the same parameters for authentication and
encryption on both devices and try to connect again.

Win32 error,

This operation
returned because

the timeout
period expired.

1. The remote device does not support the Service
Mode you selected. On the My Bluetooth Device
page, select another Service Mode.

2. There is a critical problem with the Bluetooth
module.
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Troubleshooting

Table 7-1. Most Common Errors (Continued)

Error Message Action to Take

Another application is using the GRS-1 COM2

Win32 error serial port. Close the application or release the port.
The specified The COM2 serial port is reserved for the Bluetooth
network resource
or device is no Manager.
longer available.

Port B of the GRS-1 GPS receiver, through which
the Bluetooth Manager connects to the Bluetooth
_ module, is not in command mode. Change Port B
° The device input mode back to command mode or clear the

connected. GRS-1 NVRAM. See the Operator’s Manual for
more information.

Win32 error

Obtaining Technical Support

If the troubleshooting hints and tips in this Operator’s Manual fail to
remedy the problem, contact TPS Customer Support.

Before contacting TPS Customer support about any problems with
the unit, see “Check This First!” on page 7-1 for some solutions that
may fix the issue.

Phone

To contact TPS Customer Support by phone, call:

1-866-4TOPCON (1-866-486-7266)
Monday through Friday
5 am to 5 pm, Pacific Time
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Obtaining Technical Support

To contact TPS Customer Support via e-mail, use one of the
following electronic mail addresses (Table 7-2).

Table 7-2. Technical Support E-mail

For Questions Related To... Use...
Hardware (receivers, antennas, firmware) hardware @topcon.com
GPS+ and 3DMC psg@topcon.com
OAF options @topcon.com
RTK rtk @topcon.com
PC-CDU pccdu@topcon.com
If in doubt... support@topcon.com

For quick and effective support, provide a detailed
description of the problem as described below.

When e-mailing TPS customer support, provide the following
information for better, faster service:

1.

The device’s model and configuration settings.

In TRU (Topcon Receiver Utility), click File » Receiver Info
and click Save to file. Enter a name for the file and save it to your
computer. Attach this file to the email.

The serial number of the device (located under the battery).

The system/hardware specifications for the device(s); such as,
operating system and version, memory and storage capacity,
processor speed, etc.

The symptoms and/or error codes/messages that precede and
follow the problem.

The activities being tried when the problem occurs. If possible,
include the exact steps being taken up to when the error message
or other problem occurs.

How regularly the problem occurs.
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Troubleshooting

Generally, a customer support representative will reply within 24
hours, depending on the severity of the problem.

Website

The Topcon Positioning Systems website provides current
information about Topcon’s line of products. The support area of the
website provides access to frequently asked questions, configuration
procedures, manuals, e-mail support, etc.

To access the TPS website, use: www.topconpositioning.com
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Chapter 8

Updating the Operating
System

This chapter will help you update the operating system (OS) on the
GRS-1. Updating the operating system (OS) requires that the internal
disk is formatted as part of the process which results in the complete
loss of all files, registry settings, and user installed programs.

m Formatting the internal disk results in the complete
loss of all files, registry settings, and user installed
programs.

[WARNING )

Prior to updating the OS of the GRS-1, back up all registration codes,
user data, TopSURYV jobs, or any other data that is stored on the
internal memory. Anything that is not part of the original OS will be
erased and will not be recoverable.

Required Equipment

The following equipment is required to update the operating system.
* GRS-1
* GRS-1 Power Supply
* Operating System Installation File (GMSXWM.ROM)
* SD Card

PC with ActiveSync Installed (for installing applications, e.g.
TopSURYV)

GRS-1 USB Cable

P/N 7010-0926 8-1



Updating the Operating System

OS Installation File

The OS installation file for the Topcon GRS-1 is titled
GMSXWM.ROM. This file must be obtained from Topcon prior to
proceeding.

Copy the OS installation file onto an SD card.

Format Reset

In order to update the OS, perform the following steps to enter the

Version up (operating system update) screen.

1. Disconnect all cables and remove the SD card (if inserted).

2. Power on the GRS-1, and remove the battery while it is powered
on.

3. When the GRS-1 is off, simultaneously hold the ESC and ENT
buttons while pushing the software reset button with the stylus
pen for two or more seconds (Figure 8-1 on page 8-3). The GRS-
1 turns off.

4. Release the buttons.
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Format Reset

e —

(&)

L — = O 9
Push the Software Reset I

Button While Pressing <

the Ent and Esc Buttons —

Figure 8-1. format Reset

5. Simultaneously hold the ESC, Power, and Reset buttons until a
black screen appears with text at the bottom that reads DIAG
start, then release the buttons.
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Updating the Operating System

After DIAG start flashes on the screen, the Version up screen
displays (Figure 8-2).

MOBM/EBoot/1PL)

MOBM V0.17A
[Aug 05 2008 14:46:25]

EBoot V1.06D
[Nov 25 2008 15:39:56]

IPL V1.06D
[(Nov 25 2008 15:39:56]

Figure 8-2. Version Up Screen

Installing the OS

1. Insert the SD card that contains the OS installation file.

2. Attach the external power supply. If you lose power during the
OS update, the GRS-1 could become dysfunctional.

3. With Windows Mobile selected, press the ENT button.

4. Once the screen turns green to signify that the update is complete,
press the ENT button as instructed.
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Troubleshooting

5. Finally, press and hold ESC and POWER until the GRS-1 splash
screen appears. This takes about 10 seconds.

6. Release the buttons and wait for the screen calibration process to
display. It takes about 30 seconds for the device to reboot.

Troubleshooting

If the GRS-1 hangs at the GRS-1 splash screen indefinitely after an
OS update, follow the steps below.

1.

Perform a format reset as shown in “Format Reset” on page 8-2
to enter the Version up screen.

Attach the external power supply to the GRS-1.

Select the RELOCATE option in the Version up screen
(Figure 8-2).

Press the ENT button.

This process will take a significant amount of time to complete.
Once it is complete, insert the SD card that contains the OS
installation file and install as outlined in “Installing the OS” on
page 8-4.

Installing Applications

After the OS update is complete, reinstall and register all
applications.
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Updating the Operating System

Notes:
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Appendix A

Specifications

The GRS-1 is a 72-channel GPS/GLONASS Dual Frequency receiver
integrated with an internal computer and Windows Mobile operating
system with touch screen, a digital camera, a Bluetooth® wireless
technology module, a Wireless LAN module, an electronic compass,
and an SD card slot. The portable design and product integration
allows this device to be a fully-functional, productive tool at any job.

GPS satellites above 15 degrees in elevation and
adherence to the procedures recommended in this
manual.

@ Performance specifications assume a minimum of 6

In areas of high multipath, during periods of large
PDOP, and during periods of increased ionospheric
activity, performance may degrade.

@ Use robust checking procedures in areas of extreme

multipath or under dense foliage.
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Specifications

GRS-1 Specifications

The following sections provide specifications for the GRS-1 and its
internal components.

General Details

Table A-1 table lists the receiver’s general specifications.

Table A-1. GRS-1 General Specifications

Physical
Enclosure Polycarbonate
Color Topcon Yellow and Topcon Grey
Dimensions W:93 x H:215 x D:53 mm
Weight 0.77 kg (with battery)
Antenna Internal GG
Battery Internal, rechargeable/replaceable
Backup, replaceable
Controller Integrated; uses Windows Mobile 6.1 Classic operating

system

Keys (buttons)

Three keys:
Power — On/Off
ENT - applies settings, numerical values, and records
points; shows Windows Start menu
ESC - exits from the current screen or function

LEDs

Three LEDs:
Bluetooth/Wireless LAN — indicates Bluetooth
Wireless LAN connection status
Cell Phone - indicates Cell Phone connection status
Charge — indicates charge level

Environment

Operating
temperature

-20 C° to +50 C° with batteries
-10 C° to +50 C° using camera

Storage temperature

-30 C° to +60 C° with batteries

A-2
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GRS-1 Specifications

Table A-1. GRS-1 General Specifications (Continued)

Waterproof IP66 at closing all connector caps.
IPX4 (Weatherproof) at connecting external antenna
cable.

Power

Internal battery

Li-ion, 2500 mAh 7.4V; replaceable (BT-66Q)

Operating time

No less than 3.5 hours with GPS and cell phone use
No less than 4 hours with GPS use
No less than 9 hours without GPS and cell phone use

External power

1 port

Input voltage 8to 15 V DC (for work)
10 to 15 V DC (for charge battery)
Output 12V-3A
Consumption 5.3 W (with Windows Mobile and GPS and GSM)
Battery charger Connect the AC adaptor to charge the power port.

Available run charge when connected to a portable
external source

Charging time

within 5 hours for full charge

Charging 0°C to 40°C
Temperature
On-board Backup battery (CR2032) for timekeeping; replaceable

button-type battery; 8—10 years normal operation

Communication

Serial port

Port A of GPS+ board

Baud rate = 460800, 230400, 115200, 2400, 1200, 600,
300

Flow control = RTC/CTS

Length= 7, 8 (default)

Stop bit= 1 default, 2

Parity= None (default), Odd, Even

Bluetooth

Version: Bluetooth standard 1.2; Class 2; Profile: SPP,
DUP
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Table A-1. GRS-1 General Specifications (Continued)

Wireless LAN Transmission specifications: IEEE802.11b/g
Transmission method: Direct sequence spread spectrum
(DS-SS) communication

Access method: Infrastructure mode, Ad hoc mode
Security: WEP(128/64bit), TKIP

Frequency range: 2.4GHz (2,412~2,462MHz) (1~11ch)
Transmission output: 30mW

Transmission distance: 10m (In good visibility)

USB Version 1.1 (mini B)

Cell Phone Modem | Type: GSM/GPRS/EDGE
CDMA for US
WCDMA for Japan
GSM/GPRS/EDGE/WCDMA

Protocol: GPRS, EDGE, CDMA, WCDMA
Frequency: Quad Band 850,900,1800,1900MHz,
CDMAS800,1900MHz, WCDMA,2100MHz

Connectors and Slot

Serial port 1 port for communication with the GMS+ board (port A);
small connector

USB port 1 port for Windows Mobile; type B mini ver 1.1; connect
to PC using ActiveSync

External power port | 1 port; DC Jack type A; for connecting the AC adaptor or
external battery

External antenna Lemo connector (EPS.01.250.DLN); 5 VDC output to
connector external antenna
SD card slot 1 slot for memory storage and I/0

Windows Mobile

Processor Marvel PXA320

Processor speed 806MHz

Operating System Microsoft Windows® Mobile 6.1 Classic

Digital Camera

Pixel 2M (UXGA...1600x1200)
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GRS-1 Specifications

Table A-1. GRS-1 General Specifications (Continued)

Sensor element

1/4 inches color C-MOS sensor

Angle of View

53°x 40°

F number

3.0

Focus Range

90 cm to infinity (normal mode), 5 to 10 cm (macro mode)

Zoom

Digital zoom x2, x4, x8

Digital Compass

Axis

Three (X,Y.Z)

Azimuth angle

+/-8 degree (in level after calibration)

accuracy
Inclinometer

Axis Two (X,Y)
Angle range +/- 30 degrees

Tilt angle accuracy

+/- 2 degrees (with reference to optical axis of distance
meter)

LCD Display

Size 640x480 VGA (portrait/landscape) 3.7 inch color TFT
transmissive type

Backlight LED

Touch screen

Resistive touch screen; passive

Audio

Speaker Mono

Microphone Mono

Memory

ROM 1 GB (NAND Flash Memory)
RAM 256 MB (DDR2 SD RAM)

Connectors and Slots
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Specifications

Table A-1. GRS-1 General Specifications (Continued)

Serial port 1 port for communication with the GMS+ board (port A);
small connector
USB port 1 port for Windows Mobile; type Mini-B ver. 1.1; connect

to PC using ActiveSync or Device Center

External power port

1 port; DC jack type A; for connecting the AC adaptor or
external battery

SD card slot

1 slot for memory storage and I/O up to 2GB FAT16
format supported (SDHC cards are not currently
supported)

External antenna
port

Lemo FLS.00.250connector;
5 VDC output to external antenna

GPS Details

Table A-2 lists the GPS board’s general specifications.

Table A-2. GPS Board Specifications

Tracking Specifications

Tracked Signals GPS/GLONASS, L1 C/A Code & Carrier, GPS L2C
WASS/EGNOS/MSAS

Receiver Type G-GPS L1
GD - GPS L1/L.2
GGD - GPS/GLONASS L1/L2

Standard Channels 72

Cold Start <30 sec

Warm Start <10 sec

Reacquisition <1 sec

Survey Accuracy

Static

For L1 — H: 3mm + 0.8ppm (x baseline length);
V:4mm + 1.0ppm (x baseline length)

For L1 +L2- H: 3mm + 0.5ppm (x baseline length);
V: 5mm + 0.5ppm (x baseline length)
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GRS-1 Specifications

Table A-2. GPS Board Specifications (Continued)

Kinematic, RTK

For L1/L1 +L2 — H: 10mm + 1.0ppm (x baseline length);
V: 15mm + 1.0ppm (x baseline length)

DGPS

Post processing/RTCM: typically less than 0.5m (RMS)

Other (GPS)

Real time data

RTCM 2.3, 3.0; CMR, CMR+; TPS

format
NMEA NMEA 2.2,2.3,3.0
Output rate Upto 10 Hz

Bluetooth Details
Table A-3 lists the GPS board’s general specifications.

Table A-3. Bluetooth Specifications

Transmission

Version Bluetooth® 1.2

Method Frequency hopping spread spectrum (FH-SS)
communication

Distance 5m (in good visibility)®

Speed 1 Mbps (max.)

Other (Bluetooth)

Modulation Method

GFSK

Antenna

Internal Chip Antenna

Frequency Range

2.4 GHz (2,402 - 2,480 MHz) (0-78 ch)

Corresponding
Profile

SPP, DUN

a. Transmission distance will be affected by environmental factors. Radio
wave distance may be narrowed near reinforced concrete buildings and
large metallic furniture.

P/N 7010-0926
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Specifications

Connector Specifications

The GRS-1 has one antenna connector for radio transmission/
reception and three port connectors for power and data upload/

download.

Serial Connector

The serial connector (Figure A-1) is a sealed receptacle, 5 pin, port.
This connector is configured as port A of the internal GPS receiver.

A

/

\

No.4 ¢— No.1
Figure A-1. Serial RS232 Connector

Table A-4 gives the serial port’s pin specifications.

Table A-4. Serial Pin Specifications

Number Signal Name Dir Details
1 TXD (0] Clear to send
2 RXD I Request to send
3 GND - Signal ground
4 GND - Signal ground
5 - - Not used
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USB Connector

Connector Specifications

Rimmed in yellow, the USB connector is a sealed receptacle, 4 pin

TPS cable connector (Figure A-2).

Figure A-2. USB Connector for GGD Options

Table A-5 gives the USB connector specifications.

Table A-5. USB Specifications

Number Signal Name Dir Details
1 VDD P Bus power input
2 V- I/O Data minus
3 V+ I/O Data plus
4 - - Not used
5 GND - Ground
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Notes:
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Appendix B

Safety Warnings

General Warnings

ul}

[WARNING )

TPS receivers are designed for survey and survey
related uses (that is, surveying coordinates,
distances, angles and depths, and recording such
measurements). This product should never be used:

* Without the user thoroughly understanding this
manual.

* After disabling safety systems or altering the
product.

* With unauthorized accessories.
» Without proper safeguards at the survey site.

* Contrary to applicable laws, rules, and
regulations.

* Used near flammable gas, liquid matter, or in a
coal mine.

TPS receivers should never be used in dangerous
environments. Use in rain or snow for a limited
period is permitted.

S
gy

To avoid electric shock, do not connect or
disconnect equipment with wet hands.
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Safety Warnings

Battery Pack Warnings

Never attempt to open the casing of the removable
battery! Lithium-Ion batteries can be dangerous if
mishandled!

Do not incinerate or heat battery above 212°
fahrenheit (100° celsius). Excessive heat can cause
serious damage and possible explosion.

(W

ARNI

Tampering with the batteries by end users or non-
factory authorized technicians will void the
battery’s warranty.

* Do not attempt to open the battery pack or
replace it.

* Do not disassemble the battery pack.

* Do not charge in conditions different than
specified.

* Do not use other than the specified battery
charger.

* Do not short circuit.

* Do not crush or modify.

* Do not cover the charger while it is charging the
battery.

* Do not use a wet battery or charger.

e

Do not allow skin or clothing to come into contact
with acid from the batteries. If this does occur, then
wash off with water and seek medical advice.
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Usage Warnings

e

Do not touch the charger, AC-DC converter or a
heated part of the device for a long period while
charging the battery. There is a risk of low-
temperature burn.

Usage Warnings

el

If this product has been dropped, altered,
transported or shipped without proper packaging, or
otherwise treated without care, erroneous
measurements may occur.

The owner should periodically test this product to
ensure it provides accurate measurements.

Inform TPS immediately if this product does not
function properly.

Only allow authorized TPS warranty service centers
to service or repair this product.
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Notes:
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Appendix C

Regulatory Information

The following sections provide information on this product’s
compliance with government regulations for use.

FCC Compliance

The Federal Communication Commission Radio Frequency
Interference Statement includes the following paragraph:

This equipment has been tested and found to comply with the limits
for a Class B digital device, pursuant to Part 15 of FCC Rules. These
limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates,
uses, and can radiate radio frequency energy. If not installed and used
in accordance with the instructions, it may cause harmful interference
to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television
reception, which can be determined by tuning the equipment off and
on, the user is encouraged to try and correct the interference by one or
more of the following measures:

— Reorient or relocate the receiving antenna.
— Increase the distance between the equipment and the receiver.

— Connect the equipment to outlet on a circuit different from
that to which the receiver is connected.

— Consult the dealer or an experienced radio/TV technician for
help.

Any changes or modifications not expressly approved by the party
responsible for compliance could void the user’s authority to operate
the equipment.
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Regulatory Information

Federal Communication Commission
Declaration of Conformity (DoC) Statement

C

Model No: GRS-1

Trade Name Topcon

Responsible Party Topcon Positioning
Systems, Inc.

Address 7400 National Drive,
Livermore, CA 94550

Telephone No 925-245-8300

Industry Canada (IC) Regulatory Information
This device complies with RSS 210 of Industry Canada.

Operation is subject to the following two conditions:
(1) This device may not cause interference, and
(2) This device must accept any interference, including

interference that may cause undesired operation of this device.

L “ utilization de ce dispositif est autorisée seulement aux conditions
suivantes :

(1) il ne doit pas produire de brouillage et
(2) I utilisateur du dispositif doit étre prét a accepter tout

brouillage radioélectrique recu, méme si ce brouillage est susceptible
de compromettre le fomctionnement du dispositif.
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FCC Compliance

FCC/IC RF Radiation Exposure Statement For
Bluetooth and 802.11b/g

To comply with FCC/IC RF exposure compliance requirements, this
device must not be co-located or operating in conjunction with any
other antenna or transmitter.

For mobile operation, To comply with FCC/IC RF exposure
compliance requirements, a separation distance of at least 20cm must
be maintained between the antenna of this device and all persons.
This device must not be co-located or operating in conjunction with
any other antenna or transmitter.

The installer of this device must ensure that the antenna is located or
pointed such that it does not emit RF field in excess of Health Canada
limits for the general population; consult Safety Code 6, obtainable
from Health Canada’s website at www.hc-sc.gc.ca/rpb.

In case that the option GSM/GPRS/EDGE/UMTS/HSDPA Module
(FCC ID: QIPHC25, IC: 267TW-HC?25) is installed To comply with
FCC/IC RF exposure compliance requirements, this device has been
demonstrated co-location compliance requirement with GSM/GPRS/
EDGE/UMTS/HSDPA Module FCC ID: QIPHC25 & IC: 267W-
HC?25, which is an option for GRS. This device must not be co-
located in conjunction with any other antenna or transmitter.

For mobile operation, To comply with FCC/IC RF exposure
compliance requirements, a separation distance of at least 20cm must
be maintained between the GSM antenna provided together with
GSM/GPRS/EDGE/UMTS/HSDPA Module FCC ID: QIPHC25 &
IC: 267W-HC25 and all persons as well as between the antenna of
this device and all persons.
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Regulatory Information

European Community Declaration of
Conformity with R&TTE Directive 1999/5/EC

The following standards were applied: (R&TTE Directive 1999/5/
EEC)

* EN301489-1 V1.6.1 & EN301489-7v1.3.1 & EN 301 489-17
V1.2.1 & EN 301 489-24 v1.4.1

EN 300 328 V1.7.1

EN 301 511 v9.0.2

EN 301 908-1 & 02

EN 50371

IEC 60950-1 & EN 60950-1

The following CE mark is affixed to the device:

430,

To comply with RF exposure compliance requirements, a separation
distance of at least 20 cm must be maintained between the antenna of
this device and all persons. This device must not be co-located or
operating in conjunction with any other antenna or transmitter.

Canadian Emission Labeling
Requirements

1. Operation is subject to the following two conditions: (1) this
device may not cause interference, and (2) this device must
accept any interference, including interference that may cause
undesired operation of the device.

2. To reduce potential radio interference to other users, the antenna
type and its gain should be so chosen that the equivalent
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Canadian Emission Labeling Requirements

isotropically radiated power (e.i.r.p.) is not more than that
permitted for successful communication.

3. This Class B digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte conform a la norme
NMB-003 du Canada.

Declaration of Conformity with Regard to the
R&TTE Directive 1999/5/EC

Cesky [Czech]

[ pansk
[Danish]

Deutsch

[German]

Eesti

[Estonian]

English

Espafiol
[Spanish]

P/N 7010-0926

(Topcon Positioning Systems, Inc.) timto
prohlasuje, Ze tento (GRS) je ve shodé se
zékladnimi pozadavky a dalSimi prislusnymi
ustanovenimi smérnice 1999/5/ES.

Undertegnede (Topcon Positioning Systems, Inc.)
erkleerer herved, at fglgende udstyr (GRS)
overholder de veesentlige krav og gvrige relevante
krav i direktiv 1999/5/EF.

Hiermit erklart (Topcon Positioning Systems, Inc.)
dass sich das Gerat (GRS) in Ubereinstimmung
mit den grundlegenden Anforderungen und den
Ubrigen einschléagigen Bestimmungen der Richtlinie
1999/5/EG befindet.

Kaesolevaga kinnitab (Topcon Positioning Systems,
Inc.) seadme (GRS) vastavust direktiivi
1999/5/EU p&hinduetele ja nimetatud direktiivist
tulenevatele teistele asjakohastele satetele.

Hereby, (Topcon Positioning Systems, Inc.)
declares that this (GRS) is in compliance with the
essential requirements and other relevant
provisions of Directive 1999/5/EC.

Por medio de la presente (Topcon Positioning
Systems, Inc.) declara que el (GRS) cumple con
los requisitos esenciales y cualesquiera otras
disposiciones aplicables o exigibles de la Directiva
1999/5/CE.
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Regulatory Information

E)\)\r]vmﬁ ME THN MAPOYZA (Topcon Positioning Systems,

[Greek] Inc.) AHAQNEI OTI (GRS) XYMMOPOQNETAI
MPOZ TIZ OYZIQAEIZ ANAITHZEIZ KAI TIZ
AOINES SXETIKEZ AIATAZEIS THX OAHIIAZ

1999/5/EK.
Frangais Par la présente (Topcon Positioning Systems, Inc.)
[French] déclare que I'appareil (GRS) est conforme aux

exigences essentielles et aux autres dispositions
pertinentes de la directive 1999/5/CE.

[t 1taliano Con la presente (Topcon Positioning Systems, Inc.)

[Italian] dichiara che questo (GRS) & conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti
stabilite dalla direttiva 1999/5/CE.

EAARVIKA ME THN MAPOYZA (Topcon Positioning Systems,

[Greek] Inc.) AHAQNEI OTI (GRS) XYMMOP®QNETAI
MPOZX TIZ OYZIQAEIX AMNAITHZEIZ KAI TIX
AOIMEX XZXETIKEX AIATAZEIZ THX OAHIIAZ

1999/5/EK.
Frangais Par la présente (Topcon Positioning Systems, Inc.)
[French] déclare que I'appareil (GRS) est conforme aux

exigences essentielles et aux autres dispositions
pertinentes de la directive 1999/5/CE.

[l rtaliano Con la presente (Topcon Positioning Systems, Inc.)

[Italian] dichiara che questo (GRS) e conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti
stabilite dalla direttiva 1999/5/CE.

Latviski Ar $o (Topcon Positioning Systems, Inc.) deklarg,
[Latvian] ka (GRS) atbilst Direktivas 1999/5/EK butiskajam
prasibam un citiem ar to saistitajiem noteikumiem.
Lietuviy, Siuo (Topcon Positioning Systems, Inc.)
[Lithuanian] deklaruoja, kad Sis (GRS) atitinka esminius
reikalavimus ir kitas 1999/5/EB Direktyvos
nuostatas.
[ Nederlands Hierbij verklaart (Topcon Positioning Systems,
[Dutch] Inc.) dat het toestel (GRS) in overeenstemming

is met de essentiéle eisen en de andere relevante
bepalingen van richtlijn 1999/5/EG.

[n] Malti Hawnhekk, (Topcon Positioning Systems, Inc.) ,

[Maltese] jiddikjara li dan (GRS) jikkonforma mal-htigijiet
essenzjali u ma provvedimenti ohrajn relevanti li
hemm fid-Dirrettiva 1999/5/EC.

Magyar Alulirott, (Topcon Positioning Systems, Inc.)
[Hungarian] nyilatkozom, hogy a (GRS) megfelel a vonatkozo

alapvetd kovetelményeknek és az 1999/5/EC
iranyelv egyéb eldirasainak.
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(e Polski [Polish]

Portugués
[Portuguese]

[Hslovensko
[Slovenian]

Slovensky
[Slovak]

[(Fl suomi
[Finnish]

[]Svenska
[Swedish]

P/N 7010-0926

Canadian Emission Labeling Requirements

Niniejszym, (Topcon Positioning Systems, Inc.) ,
deklaruje, ze (GRS) spetnia wymagania
zasadnicze oraz stosowne postanowienia zawarte
Dyrektywie 1999/5/EC.

(Topcon Positioning Systems, Inc.) declara que
este (GRS) esta conforme com os requisitos
essenciais e outras disposicées da Directiva
1999/5/CE.

(Topcon Positioning Systems, Inc.) izjavlja, da je
ta (GRS) v skladu z bistvenimi zahtevami in
ostalimi relevantnimi dolodili direktive 1999/5/ES.

(Topcon Positioning Systems, Inc.) tymto
vyhlasuje, Ze (GRS) splia zakladné poZiadavky a
vSetky prislusné ustanovenia Smernice 1999/5/ES.

(Topcon Positioning Systems, Inc.) vakuuttaa
taten etta (GRS) tyyppinen laite on direktiivin
1999/5/EY oleellisten vaatimusten ja sita
koskevien direktiivin muiden ehtojen mukainen.

Harmed intygar (Topcon Positioning Systems, Inc.)
att denna (GRS) star I dverensstdmmelse med de
vasentliga egenskapskrav och 6évriga relevanta

bestdmmelser som framg%r av direktiv 1999/5/EG.
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Regulatory Information

Community of Europe
Compliance

The product described in this manual is in compliance with the
R&TTE and EMC directives from the European Community.

WEEE Directive
= 1his symbol is applicable to EU members states only.

Following information is only for EU-member states:

The use of the symbol indicates that this product may not be treated as
household waste. By ensuring this product is disposed of correctly, you
will help prevent potential negative consequences for the environment
and human health, which could otherwise be caused by inappropriate
waste handling of this product. For more detailed information about the
take-back and recycling of this product, please contact your supplier
where you purchased the product or consult.

EY, EU Battery Directive
This symbol is applicable to EU members states only.

Battery users must not dispose of batteries as unsorted general waste,
but treat properly.

Perchlorate Material — Special Handling
@ May Apply
For more information, see www.dtsc.ca.gov/
hazardouswaste/perchlorate

This applies to California, USA only.
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Appendix D

Warranty Terms

TPS laser and electronic positioning equipment are guaranteed
against defective material and workmanship under normal use and
application consistent with this Manual. The equipment is guaranteed
for the period indicated, on the warranty card accompanying the
product, starting from the date that the product is sold to the original

purchaser by TPS’ Authorized Dealers.!

During the warranty period, TPS will, at its option, repair or replace
this product at no additional charge. Repair parts and replacement
products will be furnished on an exchange basis and will be either
reconditioned or new. This limited warranty does not include service
to repair damage to the product resulting from an accident, disaster,
misuses, abuse or modification of the product.

Warranty service may be obtained from an authorized TPS warranty
service dealer. If this product is delivered by mail, purchaser agrees to
insure the product or assume the risk of loss or damage in transit, to
prepay shipping charges to the warranty service location and to use
the original shipping container or equivalent. A letter should
accompany the package furnishing a description of the problem and/
or defect.

The purchaser’s sole remedy shall be replacement as provided above.
In no event shall TPS be liable for any damages or other claim
including any claim for lost profits, lost savings or other incidental or
consequential damages arising out of the use of, or inability to use,
the product.

1. The warranty against defects in a Topcon battery, charger, or cable is 90
days.
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Notes:
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